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License Agreement

The use of Adagio GridView from Softrak is governed by the following agreement. You
demonstrate your acceptance of the terms of this agreement by using Adagio GridView and its
associated materials. You may terminate this agreement at any time by returning the original CD
and manual to Softrak Systems Inc. with a letter stating that all copies of the software have been
destroyed. The letter must be signed by an officer of the company.

Usage Rights

For the fee you have paid, Softrak Systems Inc. hereby grants to you and you accept a license to
use Adagio GridView and its related materials on a single computer system only. To use any
Adagio applications on more than one computer system, you must either purchase a license for
another copy of that Adagio product or arrange for a multi-user license from Softrak Systems Inc.
You may not copy any of the materials received with Adagio products, in whole or in part, except
for archival and backup purposes.

The license is not transferable.

Registration and Support

To receive technical support and notices of upgrades and announcements, your copies of Adagio
GridView must be registered.

To register, install Adagio GridView as you would any other Windows application. When you
start up any Adagio application for the first time, you will be presented with a screen that gives
you the option to register. Enter your company information and print the registration form to be
mailed or faxed to Softrak Systems Inc.

Adagio GridView requires registration within 60 days of first use. It will cease to operate after
60 days have elapsed without a registration code.

Liability

You agree that regardless of the form of any claim, the liability of Softrak Systems Inc. for any
damages to you or to any other party shall not exceed the license fee paid for the materials
included in Adagio GridView. Nothing in this agreement shall be construed as a product
warranty and all such warranties are explicitly and expressly denied.
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Adagio GridView allows you to create live "Views" into your accounting data. These
Views allow (non-accounting) personnel to look at accounting activity without
needing access to the accounting applications themselves. You might use Adagio
GridView to keep a customer list permanently displayed on a receptionist's desktop,
or to allow a sales manager to track current order activity.

Each View displays information from a single Adagio file. You can link Views where
there is a data field in common. So, by clicking on a customer number, you can
display a customer's active orders, or by clicking on an invoice number, you can
display the order's detail lines.

Adagio GridView has many great features that make this program both versatile and
easy to use. For example, Views may be exported to Microsoft Excel or an HTML file
directly, and only by an authorized person. The columns may be sorted instantly into
ascending or descending order. You can use Edit | Find to look for information in
the View. Columns may be re-arranged to a specific order. We're sure you'll find
many uses for these features and all the others outlined in this manual.
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Installation Notes

GridView is installed in the directory X:\SOFTRAK\GVWIN and creates both a
Samdata and a Views directory.

View definitions are their own data files and need not be stored with your
accounting data. Separating Views by subdirectory can be useful to ensure that your
staff members have access only to the Views you authorize.

Views (files) stored in the same directory may be "linked" to one another, which
means that you can open up to five Views at once, just by selecting one of the linked
Views.

Shortcuts for GridView
You will need a shortcut to launch GridView if you want to create or edit Views.
Normally, GridView is used to look at the accounting data through predefined
Views. You will not want your users to be able to modify the Views as all of the data
elements in the database are available for display. For this reason, you must specify
/c on the command line that starts GridView if you are going to create or edit Views.
This is done by creating a shortcut to the application.

If you would like to use the sample Views, you can point them to your data by
pressing F2 while the View is active and changing the data path and extension.

See the section on “Command Line Parameters” in the online help
or Adagio Fundamentals manual for basic information on setting
up shortcuts.

Installation Notes
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GridView Command Line Parameters

Command line parameters are set as properties for the program and allow you to
bypass certain fields in the Open Adagio GridView Data dialog box each time you
start up Adagio GridView, as well as providing functionality without operator
intervention.

If you are the only Adagio GridView user, or if your office is not concerned about
security issues such as the ability to block unauthorized access to Adagio GridView,
you may wish to use the following information regarding command line parameters.

Command line parameters are set as properties for the program, and allow you to
bypass certain fields in the Open Adagio GridView Data dialog box each time you
start up Adagio GridView. The parameters are as follows:

/c - Allows you to edit and create new views.

/u - Allows you to set a default user.

/p - Allows you to set a default password (/p only indicates password is 'blank').

/t<yyyymmdd> - Uses yyyymmdd as the current date.

/d - Allows you to set a default data path (must be used with /e).

/e - Allows you to set a default data extension (must be used with /d).

/w - Allows you to load a default Workspace (full path).

You can automatically open a View by entering its full path and
filename on the shortcut. You do not require a special parameter to
do this.

/f - Restricts a user not having access to create or edit workspaces and views to load
workspaces and views within the data path indicated. If the user can create new
views and workspaces, /F provides a default path only for where they will be loaded
from and saved to; this user can browse to other directories as required.

/n - Allows you to load a Named Item file (full path, must be used with /w).

/rw - Allow modify and writeback to data. Requires GridView-RW Add-on module.

/s: - Shows available GridView Server servers.

/s:<servername> - Shows a specific GridView Server server.

GV Command Line Parameters
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/s:<ip address> - Shows a specific GridView Server server on a different subnet.

/xlu - Refreshes a Locked View and saves it with the new data. Views may be locked
within the Edit Definition window (see page 2-18).

/z:<companyname> - Used when connected to GridView Server to control the
display of the company name for the connection.

/? - If you need help on the command line parameters, add this to the command
line. When you try to start up GridView, a mini-help window explaining the
parameters will appear. Once you've gotten the help you need, remove this from the
command line to bypass the mini-help window when you start up GridView.

/# - Allows non-SYS users to view encrypted data.

/! - Shows all fields from the data dictionary, including duplicates and fillers

/@:<dict name> - <dict name> is placed at the top of the selection dialog when a
new View is being created. Use the filename from the \Softrak\Dict folder (i.e.
@L90A for Adagio Ledger 9.0A). The short dictionary name is used to name the
Excel workbook created by the Data Dictionary Export Tool.

XDView Parameters
XDView parameters respect the Allow export option on the Edit Definition window
(see page 2-18). For workspaces containing multiple views, only those views with
the Allow export option enabled will be sent to Excel.

/XDN - Exports view without format and any hyperlinks.

/XLU - Unlocks and refreshes a previously locked view (refer to Edit Definition
option, page 2-18). Saves with the new data.

/XDO:<workspace> - Exports column names using ODBC compliant fieldnames (eg.
no spaces, special characters, etc.). Similar to using /ODBC parameter with the
DataDictionaryExporter.exe utility.

/XDS - Runs XDViews in 'silent' mode (eg. loading and unloading GV and Excel are
unseen).

/XDV:<workspace> or /xdv:<workspace> - Sets the location from which to both
load the view and to save the resultant Excel workbook. Enter the full path to the
workspace. The Excel workbook receives the GridView workspace name and the
individual Excel sheets inherit the GridView views' names.

/XDW:<workspace> - Launches GridView and sends the named workspace (or
View) to Excel without operator intervention. Enter the full data path to the
workspace or View. The Excel workbook is placed in the subfolder

GV Command Line Parameters
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x:\data\XDViews (where 'x:\data' is the path to your data) with the same name as
the workspace (or View). The View is refreshed prior to the ExcelDirect function
being performed. A log of the automated export is created in the file
x:\data\XDViews\GVLog.log.

/XDF:<sheetname:filtername> - Selects the named filter "filtername" for sheet
"sheetname" in a workspace. The filtername is separated from the sheetname by a
colon. Only enough of the filter name to uniquely identify the filter need by
specified. You may use multiple filternames on the command line. If the filter
cannot be found for that sheet, an error is reported in the log and the View or
Workspace will not be sent to Excel. (This parameter must be used with /XDW or
/XDP.)

When spaces exist in a "sheetname" and/or "filtername", make sure
that quotation marks surround the entire "sheetname::filtername"
on the Command Line.

/XDP:<workspace> - Launches GridView and sends the named workspace (or
View) to Excel without operator intervention. Enter the full data path to the
workspace or View. The Excel workbook is placed in the subfolder
x:\data\XDViews\UserID with the same name as the workspace or View (where
'x:\data' is the path to your data and 'UserID' is the ID of the user logged in to
GridView).

/XDD - Creates a subfolder with today's date to hold the Excel workbook under
x:\data\XDViews or x:\data\XDViews\UserID if XDP is specified (where 'x:\data'
is the path to your data and 'UserID' is the ID of the user logged in to GridView).
Folder names take the form yyyy-mm-dd and can be used to separate the ExcelDirect
runs from different dates. (Must be used with /XDW or /XDP.)

The /c parameter must be on your command line to be able to create
and edit views. Do not specify the /c parameter for users who you
want to only be able to display and refresh views. The entries on
the Windows Start menu for Adagio GridView include the /c
parameter by default. If you create a new shortcut for Adagio
GridView, be sure to add the /c parameter if you want to be able to
create and edit views. If you do not want the user to be able create
or edit views, you must remove the /c parameter from the Windows
Start menu.

GV Command Line Parameters
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Gather Files for Support

There may be times when you require the assistance of Technical Support to
troubleshoot something that is or is not occurring with your view/workspace. At
these times, you may be asked to send your view and related files for Technical
Support to review.

You must have saved your view or workspace and views first. If
you haven't, GV will prompt you to do so.

To do so, select File | Gather Files for Support from the main menu. Adagio
GridView will prompt you with the full data path that the necessary files will be
stored in. This will be in a folder called GVSupportYYYYMMDD-## within your
data folder (where

'YYYYMMDD' represents today's date and '##' is a 2-charater sequential number
beginning at '01' to prevent files from overwriting each other).

Drill down to this folder. Highlight all of the files, right click and add them to a Zip
file. Then, upload the resulting file to your Adagio consultant or to Softrak's site
(www.softrak.com/dbr), indicating your company name and yours, and flagging the
file for Technical Support.

Gather Files for Support
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This chapter outlines how to create views from scratch. Adagio GridView comes with
many pre-defined Views that you can use and edit as necessary, but since every
organization has its own very specific needs, Adagio GridView gives you complete
control over defining Views.
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Exporting Dictionaries/Tables

When GridView is installed, the Adagio Data Dictionary Exporter utility is also
installed to the Softrak\System folder.

Use the Data Dictionary Exporter (DDE) to build an Excel workbook with the
Dictionary/Table/Fields names of all of the tables for the program selected to the
data path entered when logging into the utility.

The program must be installed in the same Softrak folder that the
Data Dictionary Exporter is being run from.

You may run the DDE from the Softrak\System folder, from a desktop shortcut or
from the Windows Start | Programs | Adagio | GridView | Data Dictionary
Exporter menu.

From the Data Dictionary Exporter window, select the program's dictionaries to be
exported:

When the selected dictionary is exported, it will create an Excel workbook in the data
folder indicated when logging into the DDE. The name of the file will be the name of
the dictionary. For example, Ledger uses L and Inventory uses N. The rule is that
the '@' symbol is the first character of an Adagio program. For the old DOS
dictionaries, the '+' symbol is the first character. Therefore, if you are exporting
Adagio Ledger dictionaries, the file created will be @L and the version code (eg.
@L90A.xls).

Exporting Dictionaries/Tables
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To quickly go to a particular table, click on that table name in Column A of the first
sheet. That sheet will list the table's layout information. Use this information to help
you determine what table and contains the fields you require in your GridView
views.

Exporting Dictionaries/Tables
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Defining a View

Defining a View consists of the following steps:

1) Logging into a database.

2) Selecting the data for the View.

3) Specifying a Filter you want applied to the data.

4) (optional) Adding columns that display calculated values.

5) (optional) Linking two different Views together.

6) (optional) Saving linked Views as a Workspace.

These steps are described one at a time.

Logging Into a Database
As with all Adagio modules, you must first log into a database, specifying a user ID
and password. If you specify the user ID, password, directory and extension on the
command line in the shortcut, then you will be taken directly into GridView.

If you did not specify that information in the shortcut command line, you will have
to log in manually. (Refer to Chapter 1 for more information on Command Line
Parameters.)

All Adagio users must be registered with the system by the System Administrator.
Each user receives a unique user ID and password. This information is required for a
user to log in to the system. Users are registered within the database, in other
modules of Adagio.

Defining a View
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To Log Into Adagio GridView:
1) Start Adagio GridView by clicking on the Adagio GridView icon in your Start

menu. The Open GridView dialog box will appear.

2) This dialog box appears each time you start the program. You must enter a user
name and password in this dialog box, and verify the date, data path, and
extension before clicking OK.

Field Description

User ID /Password Each user can be assigned a user identification code in
File | User Setup of any Adagio application. Once you
have set up your users, that individual's identification
and password should be used each time (s)he enters the
program. The default User ID is SYS; the default
Password is also SYS.

Date This is the session date. It defaults to the current system
date. If you need to change the date, use the calendar
button to the right, or type it.

Defining a View

Creating Views Page 2-11



Field Description

Data path Enter the drive and data path for your company’s data
by clicking once in this field and typing the information,
or by clicking the Browse button (or using Alt/b on the
keyboard) and selecting the correct drive and data path
from the dialog box that appears.

There is an additional browse button to the far right of
this field. Click this 'multiple folder' button (or use Alt/f
on the keyboard) to view a list of Previously Opened
data sets. This feature is especially helpful if you are
maintaining multiple data sets (e.g. data for multiple
companies). If you wish to use one of these
previously-opened data sets, click the company name to
select it, then click Open.

NOTE: To see all the fields in the Previously Opened
window the first time, you may have to resize the window.

Extension Enter the extension used by your company’s data. For
example, to access the sample data you would enter
.SAM.

Remember user name
/ password

Turn the Remember user or password option on to have
the Adagio user name and/or password remembered
and authenticated by the Windows user. This allows
you to default your Adagio user name and/or password
by logging into Windows (on the same station).

Last Access date Adagio GridView displays the session date used when
you last accessed or ran the program with the data path
that initially displays in the Data path.

3) When you have entered or verified the information in these fields, click OK to
open the specified data set and begin using the program. Or, click Cancel to exit
the program at this time.

Selecting Data for the View
You need to make three choices in order to define the most basic View.

1) Select the module containing the data you want to see.

Defining a View
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As long as the External Data option in your Defaults is enabled (see page 3-37),
you may select Excel Workbooks, Island Micro data, or the File DSN or UDL for
a database. Workbooks and Island Micro Data must be in the same folder as the
Adagio data. The DSN or UDL must also be in the data folder, although the
database it connects to does not. When selecting Island Micro Data you will be
presented with a list of tables. For an Excel workbook, you will be presented a
list of the sheets in the workbook. Some rules apply for Excel files (see below).
Please also refer to Field Properties on page 3-44.

2) For memo fields, the first 508 characters are retrieved.

3) Select the table containing the data.

4) Select the fields you want.

Additionally, you may also want to set filters for your View, which will also be
explained in this section.

Using the Adagio Data Dictionary Exporter utility (see page 2-8) to
first export the dictionaries and their table layouts to an Excel
workbook is a useful way to determine which dictionary tables
contain the information/fields you will want to use in your views.

It may be that you have a view or workspace open using one set of data and that you
would like to keep the view or workspace open yet use another dataset with it. This
may be accomplished in one of three ways:

• Select File and Open Dataset from the GridView menu;
• Select Edit and Defaults (or press F2) from the menu and change the DataPath

and Extension as necessary; or
• Close the current view or workspace, restart GridView and respecify the

DataPath and Extension on the logon screen.

We recommend using File | Open Dataset as it's fast and more visible. It opens the
logon screen wherein you can select a different dataset. Views marked as Refresh on
open within their Definition will be reloaded on the change of datase.

Excel Workbook Rules
Column names must be in Row 1.

The sheet should contain no blank columns and no totals.

It must be a well formatted sheet. For example, End+Home keystrokes should take
you to the bottom rightmost cell in the sheet.

Defining a View
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Permissions
For security reasons, you may with to restrict some users of a particular dataset to
seeing data in views that pertain to their job only. For example, it may be that
someone working in the collections department does not need to see information
stored in views pertaining to company expenses or payables.

Permissions cannot be set when running GridView-RW in RW mode.

Select Edit | Permissions to access this function from the menu.

This menu option only displays for the Adagio System
Administrator (i.e. user SYS).

Users that are checked (�) are permitted to see data in views created by tables that
are also checked. Users that do not have a checkmark beside their UsesrID are
unrestricted.

The following window will display listing each of your Adagio users:

Defining a View
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Expand the table tree for the user you wish to set permissions for:

If a user is to be granted access to many or all available tables, it might be easiest to
first place a checkmark to the left of their Adagio userID. After, you will uncheck
those tables they are to be restricted from viewing the data.

It is very important to note that, if you are going to restrict a user
from particular tables (eg. all @R Adagio Receivables tables), you
should also restrict that user from all @Z Adagio Composite tables
as composite tables often contain data elements from more than
one Adagio module. Depending on the needs, you might also want
to restrict access to related module's tables (eg. OrderEntry,
Invoices or Time&Billing).

When a user that does not have access to a particular table(s) opens aview which uses
the restricted table(s), the view will display no data.

Selecting a Module
Select File | New or click the New button on the toolbar to define a new View. The
Select Module window will appear.

Defining a View
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NOTE: As long as the External Data option in your Defaults is
enabled, you may select Excel Workbooks, Island Micro data, or the
File DSN or UDL for a database. Workbooks and Island Micro
Data must be in the same folder as the Adagio data. The DSN or
UDL must also be in the data folder, although the database it
connects to does not. When selecting Island Micro Data you will be
presented with a list of tables. For an Excel workbook, you will be
presented a list of the sheets in the workbook. For memo fields, the
first 508 characters are retrieved. Some rules apply for Excel files
(see page 2-13). Please also refer to Field Properties on page 3-44.

From the list of available modules, select the list that you will be using as a basis for
your View. For example, if you want to create a View that gives information about
the status of customer orders, select Adagio OrderEntry. Then click OK. The Select
Table dialog will open.

If you have used Adagio GridView before, this window will display
up to the last 10 dictionaries you selected previously at the top.

Defining a View
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Selecting a Table
Click the table you wish to use for your View. For example, if you're creating a View
that draws information from the order header in Adagio OrderEntry, select O/E
Sales Order Header by clicking it once.

If you have used Adagio GridView before, this window will display
the last table you used at the top.

Click OK to proceed. The Select Fields window will open.

Selecting Fields
The list of fields on the left displays all fields that you can possibly include in your
View. To include fields, you need to move them to the list on the right.

Defining a View
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Select fields either by double clicking on the field, or by highlighting the field and
clicking on the right arrow to move it into the column on the right. You can also use
Windows’ multi-select feature on fields by pressing Shift+Click or Ctrl+Click to
select the fields, then click the arrow button to move multiple fields at once.

As there are a large number of fields in most tables, it is not
recommended that you select all of the fields to be displayed.

As you add new fields, they are placed at the end of the list. You
change the order of the fields by dragging the columns to different
positions in the View.

Turn 'on' the Sort Fields option to sort the list of fields to select from on the left side
of this window. If you turn this feature on, the fields will also appear sorted when
accessing them in a Filter or Calculated Column.

After you have chosen the fields, click OK to proceed. The Edit Definition dialog
will appear.

Editing Definitions
The Edit Definition dialog can be called up whenever you wish by pressing F4. The
Tables and Fields buttons on this window allow you to change the table and field
settings.

Even though a field has been selected for use within a view, you might prefer that it
not actually display within the view. To quickly 'hide' one or more fields in a view,
click the checkbox to the left of the field name. Field names that are 'checked' will be

Defining a View
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hidden in the resulting view. However, they will still be easily accessible as Selected
Fields for use within Filters or Calculated Columns.

There are some important options available that you should note on this window.

The following table explains the option fields on the Edit Definitions window.

Field Description

When exiting with changed
grids

You are provided three options:

� If any changes have been made, this option
ensures that you will be asked if you want to
save the changes when the View is closed.

� This option will automatically save the grid to
disk if changes have been made to a View and
have not been manually saved prior to the file
being closed.

� This option will not save any changes to disk.
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Field Description

Totals for numeric fields This option will add a total to all numeric
columns. This total will be recalculated whenever
the View is refreshed, and will always appear at
the bottom of the column.

Auto refresh This option will detect when the source file (the
table) has changed and will update the View,
without the user having to press F5 or F9.

If you are monitoring a file that changes
frequently (current orders, for example), then
you can set the amount of time to wait between
refreshes in the Defaults dialog (F2).

Refresh on open This option will reload the grid with current
information from the source file. Otherwise, the
data previously loaded will be displayed when
the View is opened.

Allow export This option will permit the View to be saved as a
Microsoft Excel spreadsheet or as an HTML
document. Uncheck this option if you are
concerned about security of the data.

with totals This option works along side of Allow export.
Enable it to have numeric column totals exported
with the view. Disable it to have all column
headings and row data exported only.
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Field Description

Lock View Enable this option to "lock the view". A Locked
View will not try asnd reload its data contents
when the user presses the Refresh button in the
toolbar or presses F5 of F9. This allows a View to
be loaded with specific data and used in another
workspace. Locked Views are generally used to
hold data from another dataset.

A Locked View can be refreshed only by either
unlocking the view or by executing GridView
with the /XLU command line parameter (see
page 1-3).

Hovering the cursor over the top left corner cell
of the View (the View Tooltip) will display if the
option is enabled for the View.

NOTE: This option is inactive on an open View that
is Tied to a different dataset than the one GridView
was opened with.

Save without data Enabling this option will allow you to save the
View without the data. This is useful for Views
that are only used to display the results of a
Linked View. Views saved without data also load
more quickly.

If you wish to decrypt encrypted fields for user
id “SYS” (system administrator), you must turn
this option on. Otherwise, encrypted fields will
display as encrypted regardless of the user who
logs in.

This option is inactive if Lock View has been
enabled.
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Field Description

Translate coded fields This field will display the full text meaning of
any coded fields.

For example, in a View of OrderEntry data, the
field {Doc Type} will, by default, display either
‘I’, ‘C’, or ‘O’. When you turn this checkbox on,
the {Doc Type} column will instead display
‘Invoice’ for an invoice, and ‘Credit Note’ and
‘Order’ for the other document types.

NOTE: If you are using Adagio GridViewRW, this
field is automatically disabled, even if it was selected
in the original view. However, you can still see the
translated values by viewing the Field Properties
(right click on the Column heading to select this
option.)

Blank when zero Enable this option if you prefer to have fields
with zero values display as blanks rather than
zeroes.

Tied to this dataset Enabling this option allows you to 'tie' the View
to the dataset currently used. After, the View
may be saved within a Workspace containing
Views using another dataset. In this way, the
workspace can reference data stored in different
data folders or using different data extensions.

NOTE: A Lanpak is consumed when a Tied
View is refreshed within a workspace opened
with a dataset that differs from the dataset the
specific View is Tied to.

Hovering the cursor over the top left corner cell
of the View (the View Tooltip) will display
whether the option has been enabled for the
View.

NOTE: This option is inactive on an open View that
is Tied to a different dataset than the one GridView
was opened with.

Click OK when you are done. The Filter dialog will appear.
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File Properties

When you point at the upper left corner of the column heading row, the full table
name will display as follows:

Right clicking in the same view location will pop up a menu selection for File
Properties. When you select this option, the File Properties window opens:

The window provides information about the data file being viewed, names the
associated index files and also indicates other programs the file is available to.

When you are finished, click Done.

File Properties
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Setting Filters for the View

The Filter dialog appears as the final step when you are selecting your data for a new
View (or at any time you wish to modify your View settings by pressing F6 or by
selecting Filters from the Edit menu).

If you do not want to apply any filters, just click OK. When you
click OK your View will appear in the spreadsheet window.

When you select F6 or Edit | Filters, you will see the Named Filters window, which
allows you to add new filters, or edit, duplicate or remove existing ones. You can
create Summary Filters (see page 3-60) that allow you to summarize a large number
of records into a few rows in a View. You can Format Report to create page breaks
in the view whenever the value set in the Sort Sequence changes. And, you can
import or export filters. To add a new one, click New.

The Filter dialog allows you to define a filter to apply to the data. A filter restricts the
records displayed in the View. In the Tree at the left hand side, you will see the
following headings: Fields, Selected Fields, Calculated Columns, Comparisons,
Operations, Functions.

You are also able to set whether a filter is to use a particular Sort Sequence, apply a
specific Row Format to records satisfying the filter criteria and/or to automatically
Summarize the view (assuming a Sort Sequence has been selected).
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The following table describes each of these headings:

Heading Description

Fields Lists all of the fields in the table you selected for this View,
allowing you to filter the data based on any field in the table.
Just double click on the field and it will appear in the
window at the bottom right.

For example, if you wish to make a list of outstanding,
incomplete orders, and are using the O/E Sales Order
Header table, you may wish to select the Order Complete?
field. This would allow you to filter out any orders that have
already been completed.

Selected Fields This tree lists all fields on the current View. The list will
either be presented in the order they appear on the report or
in alphabetical order, if that option was selected when
defining the View.

Calculated
Columns

The Calculated Column List is a tree view of the Calculated
Column fields that have been defined in this view and can be
used when you are defining a Filter/Calculated Column.

Comparisons Use these Comparisons to create a filter for the field you
selected above. Filters are created in the standard way, using
a set of criterion such as "greater than or equal to" combined
with a specific {Field Name} or value.

For example, if you were listing only customers with an
outstanding balance of more than $1,000.00, you could use
the A/R Customers table and select {Balance Outstanding}
as the field, "greater than" as the comparison, and then enter
a "value" of 1000.00.

NOTE: If you are not sure of the values in a field, just
display the records in a View and inspect the values in the
records. Their meanings should quickly become clear.

Operations Lists all Operators (plus, minus, multiply, etc.) that may be
used when defining a Filter/Calculated Column
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Heading Description

Functions Lists all Functions available when defining a
Filter/Calculated Column. Each Function is listed in
Appendix C and defined in detail in the Help file. Access
Help at any time by pressing F1 or selecting the Help menu.

External
references

This section of the tree appears if there are other views in the
Workspace that share an element in common with the View
you are working on. For example, the External references
within a particular view will be for the view(s) that use a
different dataset.

Expand the tree to see the names of the other views. Expand
each view to see its common elements. To add one of these
elements to the view you are currently working on, double
click on the element. This will automatically populate the
formula textbox with the proper GetLinkedValue formula
(see page 3-89) for the Calculated Column or Filter you are
working with.

You can double-click on any item in the Tree to copy it to the Edit Box. Field names
must be enclosed in { }'s. You can use cut/paste to copy a selection formula to the
Edit Box. A double slash (//) anywhere on a line indicates that the remaining text on
that line is a comment.

Example:

// Select Orders that have not been completed
AND (

{Doc Type} = "O", // Select Orders
{Order Complete?} = False() // Not completed
)

These // Comments can be used to clarify the Filter.

You can keep a list of useful filters in a Notepad document and just
cut and paste them for regular use.
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The window on the bottom right displays the existing filter conditions as you've set
them up. You can then use any available functions to create further conditions. For
instance, if you created a filter for customers with balances of more than $1,000.00,

// Customers owing more than 1000.00
{Balance Outstanding} > 1000.00

but decide that you'd also like to further specify only those customers whose balance
outstanding exceeded their credit limit, you would use the AND() function to modify
the existing filter.

// Customers owing more than 1000.00 who have exceeded their Credit Limit
AND (

{Balance Outstanding} > 1000.00,
{Balance Outstanding} >= {Credit Limit},
{Last Inv Date} < QUERYDATE("Enter Cutoff Date")
)

Click the Verify button to verify the syntax of your calculation/filter.

You will also want to provide a Name for the filter, which will appear in the Filter
drop-down box on the toolbar.

You can apply a Sort Sequence to the Filter, if you've set one or more Sort Sequences
up. See the section on Sort Sequences beginning on page 3-51 for more information.

As well, if you have created Named Row Formats, and you wish to apply one of
them when this Filter is run, click the Row Format Enable checkbox. When you do
this, the drop-down field next to the Enable checkbox will become active. From this
field, you can select the Named Row Format you want to use.

Now, when this filter is run, any of the filtered records that also meet the criteria
entered with the Named Row Format you enabled will display in the format used by
the Named Row Format selected. (Refer to page 4-117 for more information on
Conditional Row Formatting.)

As long as a Sort Sequence has been selected, enabling the Summarize option will
display the view in Summarized format when this filter is run. (Refer to
Summarizing a View on page 3-56.)

Enable the Format Report option to have the filter automatically insert Page Breaks
when the value changes in the column specified in the Sort Sequence selected. You
may remove a Page Break by selecting the rown in the view that immediately
follows the Page Break and selecting Clear Page Break from the context menu or
select to Set Page Break again. (Or, use Ctrl + B to toggle between the two.). Page
breaks are refreshed when the view is Refreshed and subtotal rows, based on your
right click column Display settings, are inserted before each Page Break.

As well, Page Breaks are Excel Directed.
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Page Breaks are removed if the view is Summarized (see page 3-48) or Display
Top/Bottom 'n' (see page 3-51).

If you wish to include a double quote (“) in a string for comparison
or formula purposes, use the escape backslash to include it. For
example, to look for all item descriptions that contain the inch
symbol (”), you would use FIND(“\”",{Description},1)0.

Click OK when you are done. When you click OK your View will appear in the
spreadsheet window.

You can find definitions and examples of all the Functions in
Appendix C. You can also find a further exploration of Filters in
Chapter 3.
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Using the Filter Toolbox
When multiple filters have been created for a view, the Filter Toolbox is a useful way
to instruct GridView to run more than one filter at a time and to further define what
results are returned. This is similar to writing a single filter wherein various
conditions are nested. You can also create new and edit existing filters from within
the Filter Toolbox. And, it can be used as an alternative to the Filters
button/dropdown (shift F6) in the toolbar.

To access the Filter Toolbox, select View | Filter Toolbox from the menu (or press
Alt/F6). The Filter Toolbox will appear to the left of the active view.

Use the TAB key to move back and forth between the Filter Toolbox and the View..

The example above lists four 'simple' filters in the Filter Toolbox. Creating and
testing simple filters one at a time is often the best way to begin creating a more
complex filter. Once each simple filter is perfected and you can see that running it
obtains the correct results, you can highlight (select) more than one filter to be run at
a time when the Apply button is selected.

As Filters and Views become more complex, use the View Notes (see
page 2-32) function to document the filters for a view and
relationship between views within a workspace.
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The following table describes each of the Filter Toolbox fields and button s:

Field Description

Filter list This area lists all of the filters that have been created for use
with this view.

Select/click the checkbox to the left of the Filter name to set
one of the following states:

* - The filter is selected to run according to the criteria of the
formula stored in the filter using AND. Multiple AND
conditions reduce the number of resulting records returned
further as all of the conditions must be true.

*! - The filter is selected to run the opposite of the formula
stored in the filter. It will use the reverse logic of the filter
and is the equivalent of an AND NOT formula. For
example, if the filter is used to select only those records
having a Line Type of R (i.e. {Line Type} = "R"), then using *!
would return all lines that are a type other than R.

+ - The filter is selected to run according to the criteria of the
formula stored in the filter using OR. Multiple OR
conditions can increase the number of resulting records
returned as any of the conditions can be true.

+! - The filter is selected to run the opposite of the formula
stored in the filter. It will use the reverse logic of the filter
and is the equivalent of an OR NOT formula. For example,
if the filter is used to select only those records having a Line
Type of R (i.e. {Line Type} = "R"), then using *! would return
any lines that are any type other than R.

S - This is a Summary Filter (see page 3-60) used to
summarize the view.

'blank' - This filter will be ignored and will not be run.

NOTE: AND filters have precedence over OR filters.

Use the spacebar or mouse to cycle thru each of the possible
states. Shift/space may be used to set all filters to ignore.

NOTE: To run the Filter(s), you must select the Apply button.
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Field Description

Apply Use this button to run the Filter(s) selected in the list. The
focus will remain on the Filter Toolbox window after the
filter(s) is run. If the view is Summarized before the Apply
button is selected, it will remain summarized after the
filter(s) has been applied.

The Apply button is inactive if no filters are selected, i.e. all
filters' checkboxes are 'blank' (ignored).

NOTE: Selecting to Refresh the data (F5 or F9) select the Apply
button if it is active.

New Use this button to create additional filters for use with this
view. The Define Named Filter window will appear.

Edit Use this button to edit the highlighted filter. The Edit
Named Filter window will appear.

Duplicate Use this button to make a copy of the filter highlighted in the
list. You must give the new filter a unique filter name to
complete the function.

NOTE: Duplicate can be useful when you are building a more
complex filter and want to start by building one part of the filter at
a time and test it before adding more complexity to the initial filter.
This way the last filter 'working' filter is left filter in tact before
adding the next level of complexity to the new copy of the filter and
testing it.

Rename Use this button to Rename the filter highlighted in the list.

Select Edit | Filters (F6) to remove/delete a fllter.

Filters may be run individually or you can select multiple filters and Apply so they
run altogether. This is fine when combining the simple filters and running them is
only being done on occasion. However, if you want to run them together often, you
can highlight each of the simple filters to be run at one time and select the New
button. When you do this, you will be taken to the Define Named Filter window
and it will look similar to the following (eg. depending on your view, the Filter
names selected may vary):
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The Reference filters by name field only appears when you are 'combining' more
than one filter into a new more complex filter. The names of each filter that is
selected in the Filter Toolbox to be combined appears in the formula box area and the
formula is automatically built for you. If the Reference filters by name option is
enabled, any changes to the formulae stored within the original simple filter will
automatically be inherited in the more complex compound filter. (If the option is
disabled, a change made to one of the underlying simple filters will have no effect on
the more complex compound formula.) Give the new compound filter a Name and
select OK to save it in the filter list.

Press Alt/F6 again or click the Close button to close the Filter Toolbox window.

Creating/Editing Notes for the View
As Views become more complex, use the View Notes and column Add Notes
functions to document the filters for a view, relationship between views within a
workspace and calculated columns or columns within a custom composite view.

To access View Notes, first select View | Notes from the menu. This option acts as a
toggle and, when enabled/checked, indicates that there are notes attached to the
active view. Subsequently, selecting the function opens the Notes window that is
attached to the view, or select the View Notes button in the toolbar. (The wndow
may be docked or undocked from the view.)
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Select Edit to open the Notes window editor:

The View Notes editor supports fonts, text alignment, bullets, tabs and color. The
notes that are entered here may also be printed.

Similar to View Notes, when you point at a column title and right click, you may
select to Add (column) Notes. This opens a simple notes editor window for entering
notes that are attached to the particular column and display when you point at that
column's title.

Saving the View
Select File | Save As… to choose a name and location for this View. It is a good idea
to keep Views for the same database in the same directory. Only Views in the same
directory may be "linked." (See the section on Linking Views in Chapter 3.)
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After the view is saved, its name will display in GridView's title bar at the top of the
screen.
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Once you have set up your own Views, you can then begin to rearrange the
information and format it to whatever way suits your needs. Among other things, in
this chapter you will learn how to:

• Change the program defaults
• Rearrange columns
• Sorting the Views
• Summarizing Views
• Format cells
• Page Breaks
• Format print-outs
• Link Views
• Record view
• Creating custom Composite tables
• Opening Views Created with Earlier Versions of Data
• Writing back to the data (GridView-RW Add-on only)

If you are working with a View that was previously saved with
data, you may need to click the Refresh button in the toolbar or
press F9 to refresh the data. This will read the latest changes to the
data into the View before you start working with the View.

However, if you are using GridViewRW and you Refresh your View
after you make changes to the data in the View, you will be
discarding your changes.
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View Defaults

The View options, which you set in the Edit Definitions window, are based on
certain defaults saved with GridView. You can change these defaults (to always
refresh a View when it’s opened, for example) by changing the GridView Defaults.
This would prevent you from having to change the View options to your preferred
defaults each time you create a new View.

Within a specific View, you can override any of the defaults you set
here.

To change your View defaults, press F2 or select Edit | Defaults to display this
screen.

View Defaults
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The following table explains the fields on this window.

Field Description

Recent file list contains Set the number of files you wish to include in the
recently opened file list, which appears at the
bottom of the File menu.

Auto refresh waits for When Views are set to auto refresh and a file is
changed, you can set a delay to prevent constant
refreshing for frequently updated files (such as
the Order Entry Sales Order File).

Extension As well as setting the default options, this dialog
allows you to instantly change the data file being
displayed in a View. Click the Browse button to
choose another path and data extension. Define
your Views using the small sample data files,
then change the View to point at your large
production files once it has been set up correctly.

Data path As well as setting the default options, this dialog
also allows you to instantly change the data file
being displayed in a View. Click the Browse
button to choose another path and data
extension. Define your Views using the small
sample data files, then change the View to point
at your large production files once it has been set
up correctly.

When exiting with changed
grids

Prompt to save: If any changes have been made,
this option ensures that you will be asked if you
want to save the changes when the View is
closed.

Save without prompt: This option will
automatically save the grid if changes have been
made to a View and have not been manually
saved prior to the file being closed.

Discard changes: This option will not save any
changes, including those that might have been
made to Filters or column order.

View Defaults
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Field Description

Fiscal Start Date If your fiscal calendar does not start on January
1st, set the Fiscal Start Date month and day. This
allows you to have Filters that refer to your fiscal
calendar. See the section on Filters in Chapter 2.

Totals for numeric fields This option will add a total to all numeric
columns. This total will be recalculated when the
View is refreshed, and will always appear at the
bottom of the column.

NOTE: If this view is subsequently exported using
Excel Direct, the formula for the total will be exported
to Excel also.

Auto refresh This option will detect when the source file (the
table) has changed and will update the grid,
without the user having to press F5 or F9.

Refresh on open This option will reload the grid with current
information from the source file. Otherwise, the
data previously loaded will be displayed when
the View is opened, and updates to the data since
then will not be reflected in the View.

Allow export This option will permit the grid to be saved as a
Microsoft Excel spreadsheet or as an HTML
document. Uncheck this option if you are
concerned about security of the data. Disabling
export also disables the ability to copy the grid to
the clipboard.

For more information on exporting, see
Chapter 5, Exporting View Data.

As table (XL 2007 or later) This field only displays if you are using Excel
2007 or later. Tables in Excel 2007, 2010 use the
successor of Excel 2003's "List" feature, with
added functionality. For more information on
using tables, refer to your Excel online help
documentation.
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Field Description

Save without data Turning this option on will allow you to save the
View without the data. This is useful for Views
that are only used to display the results of a
Linked View. Views saved without data also load
more quickly.

Add to popup summary
menu

If you want to be able to view either the total,
minimum, maximum, or average value for a
selected/highlighted cell or range of cells in your
View, you will need to select those options here.

By default, the Total option for a column will be
enabled. You can also enable the Minimum,
Maximum and Average checkboxes. After doing
so, within a view, if you select a cell or range of
cells and right-click, you will see the
corresponding values at the bottom of the context
menu. The values display in the order they
appear in the Defaults window.

Show All Tables Turning this option on instructs GridView to
display all possible modules, versions and tables
that GridView can work with, including
composite tables.

When the option is turned off, GridView displays
only those modules and tables for which Adagio
applications have been installed. This list of
installed modules may be easier to work with.

NOTE: With the option turned off, it may be
necessary to first access the data using a particular
application before that module will display inthe Select
Module window.
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Field Description

Inc lude External Tables When this option is enabled, you can select Excel
Workbooks, Island Micro data, or the File DSN
or UDL for any database. Workbooks and Island
Micro Data must be in the same folder as the
Adagio data. The DSN or UDL must also be in
the data folder, although the database it connects
to does not. When selecting Island Micro Data
you will be presented with a list of tables. For an
Excel workbook you will be presented a list of
the sheets in the workbook. Some rules apply for
Excel files. Please also refer to Field Properties
(3-44).

On Start up do Select any of the following options to run/open
when you first run/open GridView:

Nothing - Open the GridView program only.

New - Opens GridView and begins creating a
new View. The Edit Definition window is
automatically opened and the Select Module
window displays, waiting for you to make your
selection.

Open View - Opens GridView and displays the
Open window used to drill down to and select a
particular View to open.

Open Workspace - Opens GridView and
displays the Open Workspace window used to
drill down to and select a particular Workspace
to open.

Recent Files - Opens GridView and displays a
Select Recent Files window, which displays the
number of files most recently opened as specified
in the Recent file list contains # files field in your
Defaults.

Recent Workspaces - Opens GridView and
displays a Select Recent Workspace window,
which displays the number of workspaces most
recently opened as specified in the Recent file list
contains # files in your Defaults.
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Field Description

Save directory Can be used to set a default path in which to save
your GridView view definitions. Definitions
stored in the same directory may be “linked” or
"joined".

Named Item File Once you have created a Named Item File, you
can set a default Named Item File to be used as
your standard Named Item File in any View. As
with any default, this can be changed for each
View but, if you commonly use a particular
Named Item File, setting the default may save
you time when creating other Views.

Click the Browse button to the right of the
Named Item File field to locate and select a
default file for your named items.

View Defaults
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Working with Columns

When you select a column, several pop-up menu features make working with
columns very easy:

• Columns can be deleted or renamed.
• Columns can be formatted individually, or the formatting for a whole column

can be cleared easily.
• Columns can be hidden and unhidden from the View.
• Columns can be included on the View but hidden for printing purposes
• Fields within a column can be made a website or email hyperlink. It can also

be made a link to and open another file.
• You can view a field's properties by right clicking on the field's Column

Heading.

You can also:

• Rearrange the Columns (see page 3-47)
• Freeze Columns (see page 3-47).

To work with a column, select the column by clicking on the column heading; then,
right-click to see your context menu options.

Deleting Columns
Selecting a column for deletion via the pop-up menu option is a faster way to remove
a field from your View. It is the same as returning to the Edit Definition window and
removing the field from the field list.

To delete a column in this way, select the column and right-click; then click the
Delete option from the pop-up menu.

REMEMBER: The column has been deleted from the View only and not from the
data, even if GridView-RW is being used.

Renaming Columns
The Rename feature lets you change a column’s title or heading for printing or
viewing. To rename a column, select the column and right-click; then select Rename.
When prompted, type in the new column title.

You are not allowed to have duplicate column names within the same View.

Working with Columns
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Hiding and Unhiding Columns
The Hide and Unhide options work the same in GridView as in any spreadsheet
application. Click Hide to remove it from the View. You can still refer to it in
formulas and such; it just will not display.

To add it back to the display and view it again, simply select both columns on either
side of it, right-click, and select Unhide.

The Auto Hide option, available by right clicking on a column heading,
automatically hides a column if it contains no values (blanks or 0.00) from the view.

However, if you want to quickly Hide multiple columns, depending on if the column
is a standard field or a Calculated column, you could either select Edit | Definition
(F4) or Edit | Calculated Columns (F8) and easily 'check' each column you wish not
to display within the associated view.

Formatting Columns
If you want to change the formatting for an entire column, you can easily do so by
selecting the column, right-clicking, and choosing the Add Formatting... option from
the pop-up menu. This will call up a standard Formatting window with tabs to allow
you to set the font, alignment, and more.

To quickly remove formatting from a column, select the column and right-click
again, and this time select Clear Formatting... instead. All formatting you previously
set will be removed and the default formatting will be applied.

Viewing Column/Field Properties
Wherever fields are shown, you can view the properties for that field, from the data
table. To do this, right-click on the column title and click Field Properties. A window
will appear with the long and short name of the field, the length of the field, Link
Name, and so forth. Where relevant, these properties contain the Lookup Table for
the field which tells you what the field's raw value will be translated to if the
Translate coded fields option is enabled in the view's Definition (see page 2-18).
Useful for 'System Integrators', the Link Name can be edited.
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For example, if working with IMS data files, any ODBC connection, or Excel
Workbooks (or Adagio data), you can edit the Link Name, then use the Insert
Related Column function (refer to Creating a Custom Composite View on page
3-89), rather than using the GETLINKEDVALUE formula and building the formula
manually. The DataDictionaryExporter utility (see page 2-8) would be used to
determine the correct Link Name.

When going from Adagio to IMS data files or IMS to IMS, you will
need to define a View and use GETLINKEDVALUE.

Depending on the field selected, a Lookup Table that translates the raw values to a
descriptive value displays in the lower left corner of the Field Properties.

If Field Properties is accessed from the Field List of the Edit Definition window or
one of the Select Fields boxes when selecting table fields for a view, the Link Name
field is not editable. However, Adagio GridView reads through the first 50 records
using this data and displays up to five sample values for the field. The sample
values are not shown when Field Properties is accessed directly on the View as field
values already display on the View.
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Make Hyperlink
Text fields may be made into hyperlinks to send email, access a website or to open
another file. To do this, right click on the appropriate column title and select Make
Hyperlink from the pop-up context menu. Fields containing an @ symbol will be
make into email address hyperlinks. Other fields are assumed to be URLs for
websites, unless they use the FULLFILENAME or STRCAT text formulas (refer to the
online Help of page 3-162) to reference a complete path and filename to be opened.
Double click the field to activate the hyperlink.

Hyperlinks are transferred to Excel when the view is Excel Direct.

Depending on your view settings, you may need to Refresh before
the hyperlink becomes active.

To remove the hyperlink, right click on the column again and select Clear Hyperlink
from the context menu.

HINT: You are able to create hyperlinks that not only create emails but that
automatically add a Subject of your choosing to the email also. For example, if using
a view with Customer data, you might create a calculated column that uses the
following formula (or a variation thereof):

STRCAT (
{Contact} & "< mailto: " &
{Contact Email} & " > ?subject=" &
QUERYSTRING("Subject?","")

)

The ' mailto:' isn't required by al programs.

Page Breaks
Page Breaks may be inserted or removed from a view by selecting the row and using
Ctrl-B. Ctrl-B functions as a toggle.

Page Breaks are Excel Directed.

Page Breaks are automatically inserted within a view for you when the Format
Report option is enabled in the active Filter (see page 2-24).

When a view is Summarized (refer to 3-56), existing Page Breaks are removed.
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Rearranging Columns

You can arrange the columns in the View by clicking a column heading with the left
mouse button and then releasing it. The column will be highlighted.

Now click and hold in the column heading and drag the column to its new position.
During the drag operation, a thin red vertical line will appear between the existing
columns to show you where the column will appear when the mouse button is
released.

Freezing Columns

GridView allows you to freeze and unfreeze columns, similar to the freezing
functionality of any spreadsheet.

To freeze a column, select it and then choose Columns Freeze from the Format
menu. If you later need to unfreeze a column, select it again and choose Columns
Unfreeze.

The ability to freeze columns can be very useful when you have many columns on a
View and wish to always keep a certain piece of reference data on screen as you
scroll horizontally through the columns. For example, if you are viewing customer
transaction information, you may wish to freeze the customer number column.
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Sorting the Views

View data can be sorted in a couple of different ways: by doing a standard sort from
the right-mouse button pop-up menu on a column heading; or by using a Sort
Sequence in combination with filters. The next sections will explain the options.

Standard Sorts
You can re-sort the View in ascending or descending order for any of the columns.
Double-click on the column heading that contains the data you want to use to sort
the View. The column is sorted in ascending sequence. Double-clicking again will
reverse the sort order of the columns, to the descending order you want.

Multi-Level Sorts
Multi-level sorts can be set up in a View. The sort order is an attribute of a column,
and can be set by clicking the right mouse button on the column heading. You can set
the sort order for each column independently.

To sort on the contents of multiple columns, use Ctrl+Click to select all sort columns
of interest (they do not have to be adjacent). Right mouse click on the column
headings, to pop up this menu.
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First, when you want to set the sort order for a column, you can use the options on he
right-button pop-up menu to select Ascending or Descending.Select one of these
options to determine if the column will sort in Ascending (eg.A thru Z) or
Descending (eg. Z thru A) order. These options also affect what values are selected
when Display Top / Bottom 'n' is enabled.

Then, right-clicking again on the column heading allows you to select Sort. This will
sort the View into the selected sequence.

Set sort order fixes the selected columns as those that make up the sort sequence. The
records will be sorted by the column contents from left to right. The first column sort
will be the leftmost column. You can quickly change the order the records are shown
in by re-arranging the columns and clicking Sort.

Other options on this Column pop-up menu include:

Selection Description

Show sort order Will highlight the columns being used to maintain the
View sequence.

Clear sort order De-selects the columns being used for the sort.

Add column notes You may add specific notes for the selected column.
Once a note has been added, the option changes to Edit
column notes. You would select Edit column notes to
view the note contents.

NOTE: These are not the same as Notes to the View (see View
Notes on page 2-32).

Hide The highlighted column(s) will be hidden.

Unhide All columns in the highlighted area will be unhidden.

Auto Hide Automatically hides a column if it contains no values
(blanks or 0.00) from the View.

Hide when printed Will cause the columns to be hidden if you print out the
View.

Hide when
summarized

Hides the selected column only when the View has been
summarized; otherwise, the column displays in the View.
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Selection Description

Size To Fit Sizes a column to display all characters in a field. May be
useful when displaying 'Note description' fields in a
View.

Delete The highlighted column(s) will be deleted.

Rename The selected column can be renamed.

Field Properties Wherever fields are show, this option brings up a
window will with the long and short name of the field,
the length of the field, and so forth.

Add Formatting... Allows complete formatting of the column.

Clear Formatting Sets the column format to the default; clears any special
formatting.

Display Total /
Average
Minimum
Maximum

For numeric columns only, these fields let you determine
which value is displayed at the bottom of the column, if
any. If you select total, the total of all values in the
column will appear. If minimum or maximum is selected,
then either the minimum of all values in the column will
be shown at the bottom, or the maximum. The same
applies with average, where the average of all values in
the column will appear.

NOTE: These options only appear if you have set your
definitions up to allow totals on numerics, and have turned on
the applicable options in the View Defaults window.

Display Calculation This option only displays when the column you've right
clicked on is a Calculated Column (see page 3-69) and
the view is not currently summarized (see page 3-56).
Enable this option if, when the view is summarized, you
want the calculated column to display results calculated
on the Total Row as well as Summarized Row values. It
is ideally suited for calculations such as percentages.
However, it won't work differently for simple addition or
subtraction calculated columns. If the option is disabled
and the view is summarized, the results will be 'blank'.
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Selection Description

Display Top /
Bottom 'n'

For numeric and date columns only, this option only
displays when the view is not summarized. Whether or
not the results display the records at the Top or Bottom
end of the scale is dependent on whether the column is
sorted in Ascending (displays Bottom N) or Descending
(displays Top N) order. 'N, is a number that you specify.

Point at the column/row intersection in the upper left
corner of the view (File Tooltip) to display the File
Properties. This will also tell you whether the Top or
Bottom 'n' of the particular column is being displayed.

NOTE: This setting may be enabled for a single column only
within the view. You are unable to move columns while this
option is enabled.

Sort Sequences
Sort sequences are a very handy way to sort Views, as they can be named for ease of
use, and can contain multiple levels of sorts. They are used in combination with
Filters, so to begin you must set the sort sequences up; and then you must apply
them to a filter.

Setting Sort Sequences Up
To apply a sort sequence to a View, click the Sort Sequence (Double A / Double Z)
button on the toolbar.

To use the button, you may need to first reset your “File” toolbar.
To do so, select Customize from the View menu. Click on the File
option to select it. (Don’t remove the checkmark beside it, however.)
Then click the Reset button to the right, and click OK to close this
window.
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The Sort Sequence button will be added to your toolbar.

When you click the Sort Sequence button, a window will appear, listing all of the
fields included on your View:

The basic options in this window are as follows:

• To enter a title for your sort sequence, press F2 while the name (by default it is
"New Sort Sequence") is highlighted. Since Sort Sequences are used with
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Filters, it is usually wise to provide some descriptive name for them so that
you can choose the correct sort sequence when you're setting up the Filter.

• To add a new sort sequence, either click the New button or right-click on one
of the sort sequence titles. From the pop-up menu that appears, choose New
Sort Sequence.

• To rename a sort sequence, highlight the sort sequence and click the Rename
button.

• To delete a sort sequence, highlight the sort sequence and either click the
Delete button or right-click on the sort sequence title you wish to delete and,
from the pop-up menu that appears, choose Delete Sort Sequence.

• To move a sort sequence up or down in the list (if you have multiple sort
sequences), right-click on the sort sequence title you wish to move. From the
pop-up menu that appears, select either Move Up or Move Down.

Within each sort sequence you create, you can then choose which field(s) to sort by,
the order you want the field(s) sorted by, and so forth.

• First, choose the primary sort field -- that is, the main field you wish to have
the data sorted by. Click on that field to select it. It will move to the top of the
list, if it isn't already there.

• Next, click on each secondary sort field you wish to use for the sort, in the order
you want to sort by. Fields will be moved up in the list according to the order
they're clicked in. The top field will be the primary sort, the second field will
be the next sort, and so forth.

• You can change any field to sort by either Ascending (A-Z or 1-10) or
Descending (Z-A or 10-1) order. Ascending order is the default. To change the
sort order, right-click on the field of interest. In the pop-up menu that appears,
choose the alternate sort order. You will note that the field's current sort order
will be displayed either by an AZ icon to the left of the field name for
Ascending order, or with a ZA icon to the left of the field name for
Descending order.

• When multiple sort sequences are being created, use the Rename button to
change the default name to something more meaningful. You may not have
more than one sort sequence with the same name.

Close the Sort Sequences window. The sort sequences can now be applied to filters.

Applying Sort Sequences to Filters
To apply a Sort Sequence to a Filter, open the Filter window by pressing F6 or
selecting Filters from the Edit menu.

You can create a filter that simply uses the Sort Sequence to re-sort your data each
time the Filter is applied. Or you can apply the Sort Sequence to the Filter and then
apply further conditions to it. In the latter case, see the section on Setting Filters for the
View beginning on page 2-24 for complete information on filter conditions.
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Creating the Filter
To create a new Filter that uses a Sort Sequence, click New from the Named Filters
window. The following dialog box appears:

First, you will want to provide a Name for this filter, perhaps something that
indicates the sort order that will be used when the filter is applied.

Then, move up to the Sort Sequence section of the window, above the Name field,
and click the Enable checkbox to apply a Sort Sequence to this filter.

When you do this, the drop-down field next to the Enable checkbox will become
active. From this field, you can select the Sort Sequence you wish to use. Notice that
the Sort Sequences listed here are shown with the names you provided for them
when you created them.

If desired, apply further conditions to the Filter. See the section on Setting Filters for
the View beginning on page 2-24 for complete information on setting up filter
conditions.

To save this Filter, click OK.

Click OK one more time to exit the Named Filters window and return to your View.
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Applying the Filter
Once the Filter has been created for the Sort Sequence, you can apply it to your View
very easily.

Ensure that the Toggle Filter button is turned on in your toolbar. (NOTE: This button
is not available if you are not allowed to edit Views. See your System Administrator for more
information.)

Next, move to the Filter drop-down beside this button:

Click the down arrow and select the desired Filter, according to the name you
entered for it earlier. The data on your View will be sorted accordingly.
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Summarizing a View

Please read the topic on creating Summary Filters (see page 3-60) also.

You can summarize a view by whatever column(s) you wish. This provides an
at-a-glance type of summary based on your column choice, with subtotals; and can
then be expanded to show complete details. For example, if you wish to summarize
a current transaction list based on the transaction date, click the Summarize button
in the toolbar or select View | Summarize from the menu. When you do so, the
amount columns are subtotalled for each date, and then you can double click to view
all transactions for a particular date individually.

Summarizing data can take some time. For large datasets, we
recommend working on a local copy of data rather than using the
data over a network. If you need to cancel a summary, press
Escape. Page Breaks are removed when a view is Summarized.

To do a summary, follow these steps:

Choose a column to sort by (see Sorting the View on page 3-48). This should be the
field that you want to have summarized, such as transaction date in our example.
You can select more than one column and the sort columns do not have to be
adjacent; however, the sort sequence will always go from left to right, with the
leftmost column being used for the primary sort.
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The resulting View follows:

Click the Summarize button on the toolbar or select View | Summarize from the
menu..

You will see something like this:
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Double clicking on the gray ++ to the left of each row will expand a particular
summary (in this case a particular date) to show all transactions included in that
summary. For example:

If you want to collapse a partcular set of summary detail rows, double click the gray
-- symbols to the left of the summary row for the detail (located at bottom of detail
rows).

For each column used to Sort/Summarize the data, you will be able to expand the
View to “drill down” into a level of detail. Summarizing a View results in the values
being summarized to the primary Sort column.

When the summarization results in multiple text value being detected in a column,
the display of that column is set to blank. If all the records in the summary contain
the same text in a column, then that text will be displayed. You can use the Auto
Hide column option to automatically hide a column that is not meaningful in a
summarized View.

The space bar key works just like a double click does while in
Summarize mode. If you want to use the space bar to expand or
collaps some summarized data, click on the row to select it, then
press the space bar.

For Calculated Columns (see page 3-69) when the view is not summarized, if you
right click on the column heading, you may select Display Calculation. Enable this
option if, when the view is summarized, you want the calculated column to display
results calculated on the Total Row as well as Summarized Row values. It is ideally
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suited for calculations such as percentages. However, it won't work differently for
simple addition or subtraction calculated columns. If the option is disabled and the
view is summarized, the results will be 'blank'.

Create Summary View
When the view is summarized and has a file name (i.e. was saved at some time), you
can point at the column/row intersection in the upper left corner of the view, right
click and select the Create Summary View option to instruct GridView to
automatically create a new view containing the summarized results from the original
view.

Fields display the value selected for the column (i.e. Display Total, Minimum,
Maximum or Average). If Display Calculation was enabled in the originating
(parent) view, it will also be enabled in the newly created view.

You can right click and use the Display Top/Bottom 'n' column calculation to display
the top/bottom values or datres from a summary view (for example, the top/bottom
product sales or customers from a transaction summary).
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Summary Filters

Summary Filters allow you to summarize a large number of records into only a few
rows in a View, with much faster calculation and load times than summarizing a
large number of detail rows. Only the rows needed are created.

You may specify a Filter to apply to records when they are read from the database
and another Filter to apply after the summary records have been created. The second
Filter might exclude records whose summary does not meet a particular threshold
value. Separate Row Format rules can be used to highlight summarized rows.

Any amount or date field can be summarized. The type of summarization (total,
min, max, average) is controlled by the attributes set for the column (eg. right click
column heading's context menu). Date columns only support Min and Max
processing. You can display the Top/Bottom N records in the View for a given
column value. Summary Filters can have Sorts, Filters and Row Formatting
included, which will be processed after the summarization of the view is complete.

Summary filters are created from the Named Filters window (Edit | Filters or F6) by
selecting the New Summary button:
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Complete the Edit Summary Filter window according to the following table:

Field Description

Name Assign a unique name for the summary filter.

Apply this filter to
data records

Enable this option to activate the dropdown field
underneath. Then select a filter from the dropdown that
should be run on the data records in the view prior to
the summarization being completed.

NOTE: If the filter you wish to run does not currently
display in the dropdown field, you may use the New Filter
button to create the particular filter 'on the fly' that you want
to use.

Select columns to
summarize

This box displays each field/column displayed in the
original view. Enable each field the summarized view is
to be summarized by. Select only those fields that
should display in the final summarized view.

Use the Move Up/Move Down buttons to prioritize the
order the selected fields are to be summarized in. These
buttons do not affect the order the selected fields display
in the summarized view.

Display summary
values

This box displays each field for which a summary value
(eg. total, average, minimum, maximum) may be
displayed. Select only those fields that should display
in the final summarized view.

Apply this filter to
summarized rows

Enable this option to activate the dropdown field
underneath. Then select a filter from the dropdown that
should be run on the records in the summarized view.

NOTE: If the filter you wish to run does not currently
display in the dropdown field, you may use the New Filter
button to create the particular filter 'on the fly' that you want
to use.
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Field Description

Sort Sequence You may apply a particular Sort Sequence of fields in
the resulting summarized view. Enabling the option
will activate the associated dropdown from which you
would select the sort sequence.

If you don't see the particular Sort Sequence you want
to use in the dropdown, use the '+' button to easily
create it. Refer to page 3-51 for more information on
Sort Sequences.

Row Format You may apply a particular Row Format (style) to fields
in the resulting summarized view that meet the row
format criteria. Enabling the option will activate the
associated dropdown from which you would select the
row format to be used.

If you don't see the particular Row Format you want to
use in the dropdown, use the '+' button to easily create
it. Refer to page 4-117 for more information on Row
Formatting.

NOTE: For modules that support Adagio Styles, you may
also use the Auto Styles button in the toolbar to toggle the
display of style assigned to master records in the view.

Top/Borrom "n" Enable this option and select whether you want to
display the Top # or Bottom # summary value records
in the summarized view.

Select column This field is only active if the Top/Bottom "n" option has
been enabled.

Select the summary value field you want used to
determine the Top # or Bottom # records that will
display in the summarized view. Only summary value
fields that have been selected to display on the
summarized view will appear in the dropdown.
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Field Description

Enter the number to
select

This field is only active if the Top/Bottom "n" option has
been enabled.

Enter the number of summary values you want to
display. For example, if you select to display the Top 10
of a particular value, each record that contains one of
these values will be displayed.

Suppress Other This field is only active if the Top/Bottom "n" option has
been enabled.

Normally, records that fall outside of the Top/Bottom
"n" selected are totalled and reported as **Other**. If
you prefer that they not be reported at all, enable the
Suppress Other option.

As Filters and Views become more complex, use the View Notes
function (see page 2-32) to document the filters for a view and the
relationship between views within a workspace.

Once your Summary Filter has been created, use the Toggle Filter button in
the toolbar and to select the Summary Filter from the dropdown. Then, Refresh (F9)
the view to activate the summarization.

Summary Filters display in both the Filters dropdown in the toolbar and in the Filter
Toolbox preceded by an S.
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Using the Find Feature

Whenever you have a View open, you can quickly search through the displayed data
if you need to find a particular record or value.

To search the View's data, select Find from the Edit menu or press Ctrl+F. The Find
window will appear.

In the field labeled Find What, enter the text or number that you are looking for, then
click the Find Next button. This will find the next instance of your text or number
starting from the currently selected cell.

The following table describes the further options available on the Find window.

Field Description

Match Entire Cell Click this checkbox on if you want to find only cells that
contain the exact and entire contents of the search string
you entered. For example, if you are searching fields
with a value of 100 and you turn this checkbox on, only
fields with the exact value, 100, will turn up in the
search. If you left this checkbox off, a search for the
value 100 would return 100, 1000, 2100, and so forth.

Match Case Click this checkbox if you want the search results to
match the case (upper and lower) you used when you
entered the search terms.
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Field Description

Search by Choose whether you want the search to go row by row,
or column by column.

If you know that the value you're searching for will be
in, for example, the Cust # column, you may find it most
efficient to search by column, and start with the cursor
at the top of that column.

The Find Again Command
There is another Find command on the Edit menu: Find again. If you conduct a
search using the Find option above, and at some point close or end the search
because you think you've found the record you wanted, you can quickly resume the
search at any time by selecting Find again from the Edit menu. This will pick up the
search again, with the same search values and criteria as before.

Here’s an even easier shortcut: use the keyboard commands
Ctrl+Shift+F to resume the search. Keep pressing that key
combination to find the next occurrence of your search term.
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Removing Fields from a View

Definition Window
You can modify the contents of a View by removing fields from the field list at any
time. To do so, you simply need to use the right button options to delete the fields or
edit the View's Definition.

To change the fields displayed in a View, press F4 or Edit | Definition. When the
View definition is displayed, click Fields or press Alt+F. The field selection form is
displayed. In the right-hand field list box, select the field(s) to remove, then click the
left arrows to remove the fields from the field list.

When finished, click OK. The View will be refreshed with only the fields chosen now
displayed.

Even though a field has been selected for use within a view, you
might prefer that it not actually display within the view. To
quickly 'hide' one or more fields in a view, click the checkbox to the
left of the field name. Field names that are 'checked' will be hidden
in the resulting view. However, they will still be easily accessible
as Selected Fields for use within Filters or Calculated Columns.

Delete Columns
You can also remove fields from a View via the right-button pop-up menu.

Selecting a column for deletion via the pop-up menu option is merely a faster way to
remove a field from your View. It is the same as returning to the Edit Definition
window, as described above, and removing the field from the field list.

To delete a column in this way, select the column and right-click; then click the
Delete option from the pop-up menu.

REMEMBER: The column has been deleted from the View only and
not from the data, even if GridView-RW is being used.
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Restricting Records in a View

To restrict or filter the records selected from the file, you must define a Filter. A Filter
is a sequence of tests that a record must pass in order to be displayed. You may
compare a field to a constant value, or to the contents of another field in the data
record. Calculated Columns may also be used in a Filter.

You may have already set up Filters when you created the View. But you can create
or edit Filters at any time. For more information on using the Filter definition
window, see the section on Filters in Chapter 2.

The filter window either appears as the final step when you are selecting your data
for a new View, or any time you wish to modify your View settings, simply by
pressing F6 or by selecting Filters from the Edit menu.

First you will see the Named Filters window, which allows you to add new filters, or
edit or remove existing ones.

To add a new filter, click New.

Filter Example
Let's assume that in one View, you wish to list only invoices from OrderEntry, and
no orders or other document types. To do this in the Filter window, simply select
Doc Type is equal to I (for invoices), and click Done.
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If you also wanted to list only invoices after a particular date, you could select Doc
Type is equal to I, as above, and then also filter on a date field using the And button
in the lower, right corner to add a second condition to the filter.

If you are filtering on a Date field, you need to enter a comparison value using the
DATE() or DATEVALUE(S) function. To make it easier to restrict a View to ranges of
dates, GridView knows about some date ranges. Use Today, BeginWeek,
BeginMonth, BeginYear, FiscalStart to get today’s, this week’s, this month’s and this
year’s (calendar and fiscal) records respectively. (See Appendix C for a complete list
of available Functions.)

You may wish to suggest a specific date, such as July 23, 2003, by entering 07/23/2003;
or you may wish to select, say, all invoices in this calendar year, by using the
BeginYear range.

When you point at the view intersection of columns and rows (View Tooltip in upper
left corner of view) The Table name displays in a Tooltip. If there is an active Filter,
its Filter Definition also displays in the Tooltip.

If you have created multiple filters for a view, please also refer to Using the Filter
Toolbox on page 2-29.

Importing/Exporting Filters
Filters can be exported from one View and imported to another. Filters that refer to
other calculated columns, will have the formula of the referenced Filter expanded
into the exported text. By using Export and Import, you can build a library of useful
Filters.

To export a filter, click the Export button in the Named Filters window. You will be
asked to assign the filter a file name, and to specify a file location. Filters are saved as
.txt (text) files. Simply enter the desired location and file name and click Save. A
window will then appear asking you to select the filters you wish to export. You can
select just one from your current View, or several, or all of them. Click in the
checkbox beside each filter of interest to select it, or use the Select All button to
choose all of them. Then click OK. Your file will be exported.

Importing is a reverse of this process. To import a filter, click Import in the Named
Filters window. The window that appears will list the available filters in the text file.
Click in the checkbox beside each one you wish to import, and then click OK.

Hitting Ctrl+A selects all items in one particular filter tree (that is,
the named filter and all of its components).
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Creating a Calculated Column

If you wish to include a double quote (“) in a string for comparison
or formula purposes, use the escape backslash to include it. For
example, to look for all item descriptions that contain the inch
symbol (”), you would use FIND(“\”",{Description},1)0.

You can insert calculated columns to the View, based on the content of other fields
from the selected table.

To start defining a calculated column, select Edit | Calculated Columns or press F8
in the View. The Calculate a Column Window will open.

For example, let’s assume we’d like to calculate and view the difference between the
Total Order value and the Total Dollar value of our OrderEntry orders.

Enter “Difference” as the column title. Next, double click on + Fields to get the list
of available {Fields}. Scroll down in the {Field List} until Total Order Value and
Total Dollar Value are visible.

Double click on Total Order Value and {Total Order Value} will be copied to the
Calculated Column Edit Box. Enter a -(dash) in the Edit Box or double-click on the
- in the Operation Tree. Double clicking on Total Dollar Value copies {Total Dollar
Value} to the Edit Box. Your calculation is now complete.
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You can type your calculation directly into the Edit Box or use Copy/Paste. Field
Names must be exactly as shown in the {Field List} and be enclosed in braces ({}).

You can reference another calculated column in a formula, as long as it is defined
before the column that uses the intermediate calculation. It is often useful to build
complex calculations in stages, making sure that intermediate results are being
calculated properly as the formula is being built. You can easily hide the results of
these intermediate calculations during the construction of a complex View.

External references appear in the tree if there are other views in the Workspace that
share an element in common with the View you are working on. For example, the
External references within a particular view will be for the view(s) that use a
different dataset. Expand the tree to see the names of the other views. Expand each
view to see its common elements. To add one of these elements to the view you are
currently working on, double click on the element. This will automatically populate
the formula textbox with the proper GetLinkedValue formula for the Calculated
Column or Filter your are working with.

Click Verify to check that your calculation is correct.
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Once you’ve finished setting up your calculation, click OK. A list of calculated
columns for the View will appear, such as:

You can call up this list at any time by pressing F8 or by selecting Edit | Calculated
Columns. You can Edit, Remove, Import or Export the column you just created, or
create another New calculated column.

Even though a calculated column has been created for use within a view, you might
prefer that the column not actually display within the view. To quickly 'hide' one or
more calculated columns in a view, click the checkbox to the left of the column name.
Calculated Columns that are 'checked' will be hidden in the resulting view.
However, they will still be easily accessible for use within Filters (see page 2-24) or
other Calculated Columns.

The Calculate after refresh option is used to insert the actual formula into the cell
allowing it to calculate and display results after the processing is complete. For
example, this can be useful in summarized views wherein you want the displayed
result of the calculation to be based on the summarized view.

After disabling the option, you may need to force the view to
refresh/reread the data to see the change.

Select OK to finalize the addition of the column(s) to the View. When you click OK
in this dialog, the column(s) will be added to the View, after the last column that is
already included on the View. You can then move it if you wish.
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Editing/Removing Calculated Columns
When you wish to edit an existing column, you must either press F8 or select Edit |
Calculated Columns. A list of Defined Columns appears (as above); just select the
column you wish to modify by clicking it once, and then click Edit.

Or, if your cursor is in the calculated column you wish to edit, you can press F8 or
select Edit | Column Definitions, which will bypass the need to select the column
name from the list of Defined Columns.

Or, once a Calculated Column has been created, you can quickly edit it by right
clicking its column heading and selecting Edit from the pop-up menu.

You are then presented with the Edit Calculated column window. To make a
change, you may edit the calculation in the Edit Box. You may use Copy/Paste to
move selected text to and from the Edit Box. You might choose to enable the Hide
option. This will hide the column so that it will not display within the view.
Disabling the option also makes it easy to Unhide a column normally hidden in the
view.

From the Calculated Columns window, use Remove to delete a Calculated Column.
If a Calculated Column is used in a Filter, you will not be able to remove it until it is
deleted from the Filter.

You can also delete a Calculated Column by selecting it in the View
(just click its heading to select the entire column), right-clicking,
and choosing the Delete option from the pop-up menu.

When you're finished, click OK to save the change to the calculated column(s).

Importing/Exporting Calculated Columns
Calculated columns can be exported from one View and impoted to another. To
export a calculated columns, click the Export button in the Calculated Columns
window. You will be asked to assign a file name, and to specify a file location.
Calculated columns are saved as .txt (text) files. Simply enter the desired location and
file name and click Save. A window will then appear asking you to select the
calculated columns you wish to export. You can select just one from your current
View, or several, or all of them. Click in the checkbox beside each calculated column
of interest to select it, or use the Select All button to choose all of them. Then click
OK. Your file will be exported.

Importing is a reverse of this process. To import a calculated column, click Import in
the Calculated Columns window. The window that appears will list the available
calculated columns in the text file. Click in the checkbox beside each one you wish to
import, and then click OK.
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Hitting Ctrl+A selects all items in one particular calculated column
tree (that is, the calculated column and all of its components).

Displaying Multiple Views

When you have two Views open (using the File | Open command), you may wish to
arrange your Views so that you can see them both at the same time. To do this, use
the Window | Tile command or press Ctrl-T to quickly arrange multiple Views.
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Linking Views

Sometimes, you may wish to link two or more Views together (to a maximum of five
from any single column in a View). When you have linked Views and you open one
of the Views which has a linked column in it, all of the Views that are linked to it will
be automatically opened if you click on a link value.

Standard Linked View Example
So why would you want to link Views? Linking Views together gives you the ability
to create custom filters. For example, if you have a customer View with basic
information about your customers, and you also have an orders View with order
header information for current orders, you could link those two Views together using
the customer number field.

A heavy red line beneathe a column heading indicates a linked column.

In the example above, you can see that the Cust # field in the customer View has
been linked to the same field in the order headers View, because the Cust # column is
highlighted by a red line beneath the column title.
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Now that you've linked these two Views, you have a built-in custom filter: Whenever
you wanted to view all of the orders for a specific customer, you would go to the
customer View, double-click on the customer number for whom you wanted to see
the orders, and the order View would automatically filter out all orders except for
that customer.

This makes doing look-ups of certain types of information very quick and easy.

If you are working with a complex view or workspace, you may
want to use the Disable Refresh button until you are finished
making your changes.

How to Link Views
To link two Views together, open the file you wish to link from. This is the file from
which you want to be able to drill-down to information in the secondary file. For
example, in the above case we wanted to create a custom orders filter, so we needed
to create the link from the customer file, where we would be drilling down to the
customer information, and link to the orders file, which contains the information we
wanted to quickly be able to drill-down to and access.
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When you've opened the file, click the right mouse button on one of the fields that
the two Views share in common (such as Cust # in the above example) and choose
Define Link from the pop-up menu. The Define Links window will open.

The following table describes the Define Links window.

Selection Description

Links This area lists the links you've already defined
for this View. If there are no links listed, or if you
wish to create a new link, click the Browse
button.

To delete an existing link, select it in the list by
clicking it once, and then click the Delete button.

Browse Click this button to choose the available Views
that you can link to. Select the appropriate
directory, click on the View file you want to link
to, then click Open. Your link will be created and
it will now appear in the Links window.

Filter After the view you want to link to is selected,
you may use the Filter button to choose one of
the Filters defined in the linked view to be
activated when the link is made. To clear a
selected Filter, click the Filter button, highlight
the link with the filter and then select the None
button on the Named Filters window.
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From the list of Views, highlight the file name you wish to link to and click Open, or
double-click the file name. Next, if you would like a particular Filter to run on the
view being linked to, click the Filter button on the Define Links window, select the
Filter and click OK. Your link will be created, as indicated by the red underline
beneath the column title of the field you used for the link.

You must activate (click on) the Linked To view in order to see the name of the Filter
you selected in the Filters dropdown in the toolbar. The option Single Click Link is
available on the right click context menu for linked rows. When enabled, you need
only click once on a linked value in the parent view to drill down and display the
related values in the child view. When disabled a double click is required.

For linked views, a Style is applied to the linked column to highlight the fact that the
value links to another View. The style gives the cell the appearance of a button. Styles
named “Link Style 1” to “Link Style 4” are provided by default and will be
automatically assigned as linked columns are created.

When you've used a linked View to drill-down to information such as a customer's
orders, in the above example, and then wish to restore the View to its original state
(such as the full list of orders, not just that one customer's), press F9 to refresh the
View.

Joining Views
When you have two Views each linked to a third View in a workspace (see page
3-84), you can create a Join.

For example, you may have a Customers View that lists all of your customers by
Customer #, linked to a Sales View that lists items sold by Customer #. You can link
those two Views together, as in the following example:
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Then, you add a third View to the Workspace (see page 3-84): an Items View which
lists all of your items by Item #, and can therefore be linked to the Sales View as well.
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So, in this situation, both your Customers View and your Items View are linked to a
Sales View. This creates an automatic JOIN between the Customers and the Items
Views.
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You can see the Join option by going to the Customers View and right-clicking in the
Cust. # column. A pop-up menu appears with a Joins option at the bottom of the
menu. When you mouse over that option, a fly-out menu appears indicating that a
join exists between this View and the Items View.

You can turn the join OFF if you wish, by clicking on it to remove
the checkmark that appears beside it.

So now that a join exists between linked Views, what is useful about a Join?

Without a Join, when you double-click on a Cust # in the Customers View, the Sales
View will change to display only that customer’s transactions. (Assuming that the
link between these files is set as an “AND” link.)

But WITH a Join, you can change the Sales View even further. Instead of only
displaying one customer’s transactions in the Sales View, you can further filter the
Sales View to show only certain items that that customer has purchased.

To do so:

• Go to the Items View and multi-select all of the items you want included in the
Sales View. For example, using Adagio’s sample data, if you want to view a
list of all bikes purchased by Ables Cables, you would go to the Items View
and select all item numbers that start with a “B”. (To multi-select, hold the
Shift key down and select the first and then the last of the items you wish to
include.)

• Next, go to the Customers View and double-click on the customer whose bike
transactions you wish to view, such as Ables Cables, customer # ABL01.
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• The Sales View will change automatically to display only Able Cables’ bike
purchases.

Working with Linked Views
Once you've linked Views together, GridView marks columns that are linked to other
Views with a red line. A column may be linked to a maximum of five other Views.
When a single column is linked to multiple Views, all the Views will be opened (or
refreshed if they are already open) automatically if a cell is double-clicked in the
linked column.
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There are two types of links: AND links or AND NOT links.

• Double-clicking on a field in a "linked" column for an AND link will show the
data in the linked View that pertains to the double-clicked field only.

• By contrast, double-clicking on a "linked" column for an AND NOT will show
the all of the data in the linked View except the data that pertains to the
double-clicked field.

"AND" Links
As we've said, double-clicking on a field in a “linked” column — one that is
underlined with red — will refresh the View that it is linked to, showing the data in
the linked View that pertains to the double-clicked field only.

In our example above, a customer list was linked to an order headers list, and with
an "AND" link, when a customer number was double-clicked in the customer View,
the orders View filtered out all orders except for that customer's orders, allowing you
to quickly see only the orders for the selected customer.

"AND" links are the default. You can see what type of link you have by right-clicking
on any field in the linked column and highlighting the Links option in the pop-up
menu that appears. An "AND" link will display a green plus sign beside the linked
file name.

To change the type of link from AND to AND NOT or back again, simply click on the
link in the fly-out menu. It will change automatically.

"AND NOT" Links
As we've said, double-clicking on a field in a “linked” column — one that is
underlined with red — will refresh the View that it is linked to, showing all of the
data in the linked View except the data that pertains specifically to the double-clicked
field only. That is, the data for the double-clicked field is excluded.

In our example above, a customer list was linked to an order headers list, and with
an "AND NOT" link, when a customer number is double-clicked in the customer
View, the orders View lists all orders on file except for that customer's orders. It
thereby excludes all of that customer's orders from the order headers list.

"AND" links are the default, but you can easily change them to "AND NOT" links. To
change the type of link from AND to AND NOT or back again, simply click on the
link in the fly-out menu. It will change automatically.
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You can see what type of link you have by right-clicking on any field in the linked
column and highlighting the Links option in the pop-up menu that appears. An
"AND NOT" link will display a red negative sign beside the linked file name.

As Filters and Views become more complex, use the View Notes
function (see page 2-32) to document the filters for a view and
relationship between views within a workspace.

Notes on Both "AND" and "AND NOT" Links
You can also multi-select values in a linked View. This will open all of the values
from the original View in the linked View. In our customer example, using an "AND"
link, if you hold down the Control key and click on all of the customers whose orders
you wish to view, then (while still holding down the Control key) double-click, the
orders for each of the selected customers will show up in the orders View.

When you've used a linked View to drill-down to information such
as a customer's orders, in the above example, and then wish to
restore the View to its original state (such as the full list of orders,
not just that one customer's), press F9 to refresh the View.

You can also save Linked views as Workspaces (see page 3-84). Workspaces may be
loaded from the command line, allowing a single click launch of a complex
accounting data View from a Windows desktop icon. See the next section for more
information.

Linking Views

Working with Views Page 3-83

Note

Note



Saving a Workspace

You can save multiple Views as a "Workspace" file. GridView will remember the
position and options for multiple Views, and load (and refresh, if selected) all the
Views when a Workspace is loaded.

To specify the order thatGridView is to refresh or recalculate the views when the
workspace is opened, select File | Set Workspace Recalc Order... from the menu.
The view you move to the top of the list becomes the active view when the view is
exported (make sure the checkbox is enabled). This will ensure the views are
recalculated in the correct order if Auto refresh or Refresh on open is enabled.
Workspaces are processed sequentially in the order in the list. One View will be
completely processed before the next View is loaded.

Set Workspace Recalc Order... may be particularly useful if you have a workspace
wherein there are multiple views and one or more of them are not to be exported (eg.
if a /XD parameter is used in the shortcut). You would arrange the sequence of
views in the newly created Excel file so there are no 'blank' sheets occurring between
sheets having data. It is also very useful if any calculated columns use the
GETLINKEDVALUE formula to ensure the view the value is coming from is recalced
first when using an /XD parameter. If a user selects View | Refresh Workspace
Data (Alt/F9) and there is no recalc order defined, the user will be prompted for the
order before the recalc is done.

If a View has Refresh on Open enabled and the Workspace order
requires refreshing subsequent Views, they will be refreshed
regardless of their Refresh on Open setting. Views not in the ‘recalc
order’ will only be refreshed in they have Refresh on Open enabled.

Workspaces may be loaded from the command line, allowing a single click launch of
a complex accounting data View from a Windows desktop icon.

Workspace files are differentiated from regular View files by a .gvs file extension.
Regular View files simply have a .gv extension.

Views (*.gv) that make up a Workspace (*.gvs) file, along with the Workspace file
itself, must all reside in the same directory. Additionally, note that all Views in the
Workspace must have been saved separately before the Workspace can be saved.
That is, you can't create a new View, link it to another View, and, without saving the
new View, attempt to save the Workspace. GridView will not save the Workspace.

The name of a saved workspace will appear in the GridView's title bar in parentheses
along with the date and time you last opened the workspace. The name of the
currently selected view displays to the left of the parentheses.
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How to Save a Workspace
To save, open, or close a Workspace, use the Workspace commands on the File
menu. They function just like a regular file save, open, or close command, but deal
with all of the linked Views in one file.

When you attempt to save a Workspace, you will see the following message:

If your View files are not all in the same folder, clicking Save & Copy will save all of
the Views to their original folder, and copy them to the Workspace folder you select.
From then on, if you change one of the copied Workspace Views, the original View
will not be affected.

If you click Save New, the files will simply be saved to the folder you select for the
Workspace. If they resided elsewhere originally, those original copies will not be
updated with your changes.

Clicking Cancel simply cancels the Workspace save operation.

If you minimize a saved workspace or make another program's window active,
pointing at the GridView icon in your Windows taskbar will display all of the same
information usually seen in the GridView title bar (eg. program name, name of view,
and workspace information).

When working with a workspace, pressing F9 will refresh the data for the active
view only. If you want to refresh the data for all of the views in the workspace, press
Alt/F9 or select View | Refresh Workspace Data from the menu.

Additionally, you may export an entire Workspace's data to Excel by selecting File |
Export to | xDirect Workspace, or holding the Shift key on the keyboard and
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clicking the Excel Direct button in the toolbar. The resulting workbook will be
created with the name of the workspace and each sheet will named the name of the
corresponding view with a dash and the name of the active filter appended (eg. the
sheetname might be ICItems-Filter1).
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'by Row' Record View

Sometimes, it is more convenient to view a single record at a time. GridView allows
you to see data in both a normal View and a Record View of information. By
highlighting a field in a row and pressing F7 or clicking on the by Rows record view
button, you can easily inspect a single record within a view.

"by Rows" record view button

Following is the 'by Row' Record View of the fifth customer in the sample data:

As you can see, column headings become the row labels in 'by Row' Record View.

The arrow buttons in the 'by Row' window allow you to move forward and
backward one record at a time, or quickly view the first or last record in the view.

You can use the splitter bar between the panels to hide more or less of the regular
View. The panel can be docked and undocked either with the View it is associated
with, or with the main Workspace window (not recommended). First, Previous,
Next, Last and Close buttons are available on the form.

Scroll the panel using your scroll wheel to easily display the information for a single
record. Displayed records will inherit the Style from the underlying record.

The 'by Row' setting is remembered for the View. F7 acts as a toggle, enabling and
disabling the function.
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You may need to Refresh (F9) the view to display the fields in the
'by Row' record view in the same order as they display in the whole
View.
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Custom Composite Views

A compositeview contains fields from more than one table in a single view. The
fields within composite tables may also come from tables for other applications.
Although there are a number of composite tables included with Adagio, there may
be times when you need to create your own custom composite view. It may be that
you want to add fields from an external view to another view that contains the same
Link identifier. Or, it may be that you want to add a field from one view within a
workspace to another unrelated (i.e. no common Link identifier) view within the
same workspace that does not already contain that field.

A Link identifier is a field that displays within the Link column of
a table definition. It may be seen using the Data Dictionary
Exporter (see page 2-8).

In either case, you would always start by opening or creating multiple views in the
same window, or by opening an existing workspace that contains multiple views.

If you are working with a complex view or workspace, you may
want to use the Disable Refresh button until you are finished
making your changes.

Single Composite Table View
Use the Data Dictionary Exporter to export the contents of the tables necessary for
your composite view. Ensure that each table contains the same Link identifier (eg.
ARCUST). Create a view using a table that contains most of the fields you want (eg.
AR Transactions).

Create one or more external views using a table (eg. AR Customer Master) that
contains the field you want to add to the original or destination view.

In an external view, right click on the column heading of the field you want to copy
to the other view and select Copy column to another View from the pop-up menu.
Then, right click in the column heading row of the destination view you want the
new column field to appear in and select Paste column from another View. The new
column field will always be pasted to the right of all existing columns.

With the destination view active, you can also use Alt+F8 or select
Edit | Insert Related Column from the menu to accomplish the copy
and paste. This function will first display the list of applications
followed by the tables within the application from which you can
choose the field to be copied. Only those tables to which the user
has been granted access will display (see Permissions on page 2-14).
Only those tables from selected application that have "Link
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identifiers" in common with the "Link identifiers" in the Primary
file (the table definition used to create the active view) will be
shown.

The newly created column is in fact a Calculated Column (see page 3-69) containing a
GETEXTERNALDATA formula. Refer to Appendix C - Function List for more
information on this formula.

When you're ready, close the external view(s) you no longer require and save the
destination view containing your new composite table.

This method may also be used within a workspace assuming the
views being copied from and pasted to both use a common Link
identifier.

Composite View from non-Link identifier tables
This type of composite view is created from fields within another view that was
created with a table that does not contain a Link identifier. The Data Dictionary
Exporter utility (see page 2-8) can be used to show if a Link identifier occurs within a
particular table.

This type of composite view may only be created within a workspace that contains
multiple views that share a common field.

If you are unable to use the copy column to another View function to copy a column
field from one view to another, create a calculated column ( see page 3-69) within the
view that you want the new field to appear. Within the calculated column, create a
GETLINKEDVALUE formula. This formula must reference the name of the view the
field is being copied from, the name of the field the two views share within GridView
and the name of the field to be copied.

Example:

GETLINKEDVALUE("Customers","Cust #","Name")

Refer to Appendix C - Function List for more information on this formula.
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Adding a Column Result from a non-Link identifier table
You might also want to add a particular column's Total, Minimum, Maximum or
Average result to a calculated column in another view. This result might then be
used in a calculation within the destination view.

Within the calculated column, create a GETLINKEDRESULT formula. This formula
must reference the name of the view the field is being copied from and the name of
the field from which you want to copy the column result.

Example:

GETLINKEDRESULT(“OECusts”, “Balance Outstanding”)

Which column results are available for use is determined within the
view's defaults (see page 3-37).

Refer to Appendix C - Function List for more information on this formula.
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Opening Views with Converted Data

If you created a View using an earlier version of the data and subsequently convert
that data to a newer release, GridView will attempt to update the View to use the
newer data tables. For example, upon opening the View you may be presented with
the Edit Definition window (see page 2-18 for more information). This allows you to
select the newer table to be used with the View.

After selecting the table, GridView will attempt to update the existing View for use
with the new table. However, if some of the fields are not recognized by GridView
(eg. the View was originally used with a third-party application converted to
Adagio), you will receive a message informing you of this. The following is an
example of such a message:

Click OK to these messages and GridView will modify the View and refresh it for
use with the newer version of the data and table.

You will be asked if you wish to save the changes.

If you say No to saving the changes, you are still able to keep the
View and save it as another filename.
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Writing Back to the Data

If you have the GridViewRW Add-on module installed, you will be able to edit data
in the View window and write the changes back to the database. Adagio
GridViewRW displays in the GridView title bar when you have GV-RW loaded:

CAUTION: No data validation is performed when write functions
are called, so only experienced consultants should use the write
functions. Before using this feature, you should have a thorough
understanding of the Adagio database and files being modified,
along with a backup of the data.

After you have selected the fields to be included in the View, you might want to
create a Filter to display only those records required to effect the change. Changes
can be manually entered into the appropriate cell(s). Or, if the change is to affect all
records in a column, you might want to create a Calculated Column to display the
desired result and copy those results to the column that requires the change to be
made in it.

Editing Cells
Click in the cell you wish to modify and either delete the contents of the cell or type
over the contents with the new or revised data. Columns and rows which contain
cells that have been edited will display a blue bar in the column heading and row
number cells.
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Selecting a Record/Row for Deletion
Select the record/row(s) to be deleted by clicking on the row number(s). Right click
on the row number and select Mark row for deletion. Selected row numbers will
appear outlined by a thick black box.

You can highlight and select more than one record to be deleted at the same time.
Records/rows do not need to be contiguous.

You cannot mark rows for deletion in Views that use tables which
act on flat files. For example, the A/P G/L9 Transactions Batch
table acts on the APALBTCH.xxx data file which is a flat file .

If you want to deselect a row previously selected, click on that row number. Right
click and select Unmark row for deletion.

If you have revised the View and want to discard all of your edits
(i.e. you do not want to save the changes), click the Refresh Data
button in the toolbar or press F9. The data will reload, discarding
any unsaved revisions.

Inserting Rows
Select the record/row you want to appear immediately after the record to be
inserted. Right click and select Insert row. A single blank record will be inserted.

To insert multiple rows, highlight the number of rows you want to have inserted.
Right click and select Insert row. GridView-RW will insert the new blank records
immediately before the first record highlighted (i.e. before the first record at the top
of the selected records).

Updating the Database
Right click on the upper-leftmost cell that intersects the Column Headings and
numbered rows and select Update Database. This will write the changes you have
made back to the database so they are saved.

• If you have made no revisions nor marked any row(s) for deletion, the Update
Database option will not appear.

• If you have either marked a row(s) for deletion or modified a cell (but not
both), selecting to Update Database will immediately effect the change(s).
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• If you have both marked a row(s) for deletion and edited a cell in the same or
other row(s), selecting to Update Database will display the following screen:

You must turn on one or both of the options in order to update any of the data.

Leaving an option turned off allows you to effect that type of change only and will
discard the other type of changes.

Checking the Database (Integrity)
After updating the database, you should check the integrity of the database for
errors.

Right click and select Check Database.

It should be noted that running Check Database within GridView-RW, checks the
Phase 1 file integrity of the View only. It does not check the integrity of the entire
database, nor application. For example, if you have deleted a vendor from the view,
the integrity will check okay. However, it does not determine if transactions for that
vendor exist in the history table or other transaction tables within the module.

The results of the GridView-RW Check Database feature are stored in the
GVWinUpdateLog.xxx (where 'xxx' is the 3-character data extension) file within the
data folder specified when logging into GridView-RW.

It is recommended that, after effecting any changes to data, you run
the Data Integrity Check function within modules that may be
affected by the change.
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Miscellaneous Notes

• Users of Adagio GridView can add views to the Inquiry menu of all 8.0 and
higher Adagio applications. To use this feature, create a Workspace in
GridView containing one or more Views, copy the Workspace (.gvs) and
Views (.gv) it uses to ..\Softrak\xxWin\Views, where xxWin is the program
directory for the Adagio module you wish to add the view to. For example,
APWIN is Payables, LEDGER or ALWin is the General Ledger depending on
what Ledger version is in use. (NOTE: You may need to create the ..\Views
directory.)

• The Edit | Run Date feature allows you to set the run date for the view as
shown on the status bar (the bottom part of the window, on the right side).
When data is refreshed to be current, the run date will show normally. When
the date used for the last refresh is not today's date, the date will be prefxed
with a "*". Setting the run date has the same effect as logging into GridView
using a date other than today’s date. If you used a filter that used {Date} =
Today() then changing the Run Date would change the record set displayed.
You must tick the enable box in order to set the run date.
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Adagio GridView allows you to change the look of your Views, as well as modify
print options such as headers and footers. These options can make your Views look
professional and sharp.

Please note, however, that formatting options made to individual cells are not
retained when your View's data is refreshed (either by pressing F9 or opening the
View again with the auto refresh option turned on). If you wish to take the time to
format an individual cell in a View, you will probably only want to do so in order to
get a certain look on a printed copy of the View's data immediately after you finish
the formatting. The next time the View is refreshed, the formatting options will be
lost.

Formatting options made to columns will remain when a View is refreshed.
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Page Setup

You can change the page setup options to change the appearance of printed versions
of your View spreadsheets.

To do so, open the View and then select Page Setup from the File menu. The Page
Setup window will open.

The small window labeled Preview displays how your View will appear given the
options that you select on this window. The following table describes the remaining
fields on this window.

Field Description

Margins Enter the margins you wish to use for your print-outs, in
inches.

Row Headers Turn this checkbox on if you want to have row headers
appear. This is typically gray row number boxes.

Page Setup
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Field Description

Column Headers Turn this checkbox on if you want to have column
headers appear. This is typically gray field name boxes at
the top of each column.

Print Frame Turn this option on if you want to print the frame of the
View spreadsheet. This simply encloses the data with
ruled lines. You will normally want to turn this option on
if you're using the Vertical and Horizontal Lines as well
(see below). If you're not using lines, you may wish to
turn the Print Frame option off.

Vertical Lines /
Horizontal Lines

Turn these options on if you want vertical and/or
horizontal lines to appear on your printed View
spreadsheet.

Only Black and
White

Turning this option on eliminates any gray shading from
the print-out. Typically, for example, column titles have a
grayscale background; however, turning this option on
will result in a white background for column titles.

Page Setup
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Field Description

Page Order If your View is fairly wide, with numerous columns,
when you print you may find that GridView has to break
the data up onto multiple pages. This option allows you
to select how that data is broken up.

� First Rows, then Columns: The first page will include
as many columns as it can, such as columns A-G, and
then the next page will continue on with the rows
displayed on the first page (for instance, rows 1-29),
showing the next set of columns that it can fit on the
page, such as columns H-M. It will proceed this way
until all columns have been included on the report. It
will repeat this process for the next set of rows, such
as rows 30-59.

� First Columns, then Rows: The first page will include
as many columns as it can, as before; but the next
page will start afresh with the next set of rows (such
as rows 30-59) and the same set of columns (such as
A-G) as displayed on page one. It will do that until it
goes through all of the rows, and then the next page
will start afresh with the original set of rows, but the
next set of columns.

NOTE: You may prefer to use the File | Print Setup
option to change the page to Landscape mode to fit all
columns onto a page, if possible. If that's not possible,
then these fields simply give you the option of how to
break the data up in a way that's easiest for you to
handle on the printed page.

Center on Page Use these checkboxes to indicate whether you want the
spreadsheet data to be centered either vertically,
horizontally, or both ways on the printed page.

If you select the horizontal centering, then the data will
be centered between the left and right margins.

If you select the vertical centering, the data will also be
centered between the top and bottom margins.

You may choose to select both; however, most prefer to
center horizontally only.

Page Setup
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Field Description

Save settings to
profile

Turn this option on if you want to save these settings for
future Views that you create. If you check this option,
then new Views will retain the same options, unless you
override them.

Page Setup
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Display Settings

The Display Settings in GridView allow you to change the way that your View
appears on screen, but does not affect the way it is printed out. (Use Page Setup
from the File menu to change the way your View appears when printed.) Display
settings are useful if you want your View to look a particular way on screen, but you
want it to look differently when printed out.

To change your display options, select Properties from the View menu. The Display
Settings window appears.

The small window at the top right, labeled Preview, shows you what your View will
look like on screen given the options you have selected on this window.

Display Settings
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The following table describes the fields on this window:

Field Description

3-D Buttons Turn this checkbox on if you wish to have a
raised three-dimensional appearance to your
column and row headings.

Vertical Lines Turn this option on if you want vertical gridlines
to separate the columns on your View. If you
would prefer having no lines, click this option
off.

Horizontal Lines Turn this option on if you want horizontal lines
to separate the rows on your View. If you would
prefer having no lines, click this option off.

Color You can change the color properties of any of the
items listed here, first by clicking the item for
which you want to change the color settings, and
then by clicking the color choice.

For example, if you want the grid lines to be red
instead of black, you would click Grid Lines in
the list, and then click the red box.

Preview This area of the window provides a preview of
how the changes you make in the Tittles and
GridLines and Color areas will affect the View's
display on screen.

Reset Selecting this button will return all Display
Settings to their original program default
settings.

Save settings to profile Turn this option on if you want to save these
settings for future spreadsheets that you create. If
you check this option, then new spreadsheets
will retain the same options, unless you override
them.
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Headers and Footers

You can change the header and footer information that appears on any printed
versions of your View spreadsheets.

To do so, open the View and then select Header / Footer from the File menu. The
Header / Footer window appears.

The main area of this window, labeled Header / Footer, allows you to modify the
contents of the header and footer. To work with the header, click the Header tab; to
work with the footer, click the Footer tab (both are located at the bottom of this main
area).

You can have up to ten lines of header and footer content, although you will usually
want to use just one or two. Type the contents of each line of information as you wish
it to appear. Use the following codes as necessary.
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Code Description

$D Prints the system date.

$F Prints the file name (including the time the data was last
refreshed/updated, either through your View settings or by
pressing F9).

$L Print the Filter name.

$N Prints the total number of pages in the printout.

$P Prints the page number.

$T Prints the Run date (session date).

$V Prints the Filer expression..

$Y Prints the Table name

$Z Prints the Table description

You can add hard-coded text in, as desired, such as Date: $D which will print the
word "Date: " and the current date. Or, you might enter $P / $N to show the page
number, a slash, and then the total number of pages.

The following table describes the remaining fields and buttons on the Header /
Footer window.

Field / Button Description

Font Click this button to change the font of the header and footer.

Distance to Frame The Distance to Frame fields allow you to set the amount of
space you wish to have between the header and footer
information and the actual View data on the printed page.
For example, if you set it to .2, then there will be .2 inches
from the bottom of the header to the top of the data.

Page numbering Enter the number you wish to see on the first page of the
printed document. Usually you will want to leave this as
auto, which will set the first page to one.
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Field / Button Description

Save settings to
profile

Turn this option on if you want to save these settings for
future Views that you create. If you check this option, then
new Views will retain the same options, unless you override
them.

Click OK once you have completed setting up your headers and footers. Or, click
Cancel to close this window without saving any changes made.
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Changing Cell Formatting

You can change the appearance of cells, affecting both the View on screen and on
print-outs. Your options are to:

• Select an entire column or row of cells (or multiple columns/rows) to change
at once. To do this, highlight the column headings or row headings for the
areas you wish to change, and select Format | Cells.

• Change the appearance of only specific cells, by selecting the cell and
right-clicking. From the pop-up menu that appears, select the Format Cells
option.

In either case, you are presented with the Cells window. This window has six
separate tabs. Each tab is discussed here separately.

You can also use the Format | Lookup command to see what the
formatting is for a particular cell. The fields and features of the
Lookup window are the same as the Cell formatting tabs above.

Changing Cell Formatting
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The Font Tab
The font tab allows you to change the font, font attributes, size and color.

The following table describes the fields on this tab.

Field Description

Font Select the font you wish to apply to the selected cell(s) by
scrolling through the font list here. When it is selected, it
will appear in the box on top of the font list.

Outline Select the effects you wish to apply to the selected cell(s).
You can bold or italicize the cells, or both; or use normal
(not bold, not italicized) typeface.

NOTE: You can also apply the bold, italics, and underline effects
to your cell(s) using the buttons on the toolbar.

Size Select the font size you wish to use here.

Strikeout The strikeout effect will draw a line through the text in the
cell(s). Turn this checkbox on if you wish to apply a
strikeout to the cell text.
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Field Description

Underline Select this checkbox if you want to apply an underline to
the text in the selected cell(s).

Textcolor If you wish to change the text color for the selected cell(s) to
something other than the default black, use this drop-down
box and select the desired color from the list that appears.

Preview This area of the window displays a preview of the font
options you've selected for the cell(s).

The Color Tab
This tab allows you to change the colors of your cells. Notice that the small window
at the bottom right displays what your cells will look like according to the changes
you make on this tab.
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The following table describes the fields on this tab.

Field Description

Interior This field applies shading or other designs (such as stripes)
to the background of the selected cell(s). Use the
drop-down box to select any shading options other than the
default white background.

Selecting the " ****** " option will remove any
shading from the selected cell(s) and will result in a default
white background.

Foreground Applies a color to the foreground of the cell. If you have no
shading option selected (see the Interior field above), the
color you select here will apply to the whole cell, as a cell's
background color. If you have a shading option selected,
the color you select here will be used to replace the gray or
black defaults shown in the Interior field.

Background Applies a color to the background of the cell. If you have no
shading option selected (see the Interior field above), the
Background color field will not have any affect; you would
instead use the Foreground color to change the color of the
whole cell.

However, if you have a shading option selected, the color
you select here will be used to replace the white defaults
shown in the Interior field. (The Foreground color will
replace the gray or black defaults shown in the Interior
field.)

3D-Effect Use these radio buttons to create a three-dimensional
appearance for your selected cell(s).

The Normal and Default options will create a normal, flat
effect without a 3-D appearance.

The Raised option will give the selected cell(s) a "raised
button" appearance.

The Inset option will give the selected cell(s) a "depressed
button" appearance.
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The Borders Tab
This tab allows you to change the way that the borders of your selected cells will
appear.

The following table describes the fields on this tab.

Field Description

Border Click once in these Border fields to turn on the top, bottom,
left, or right borders. When the boxes are grayed out, no
borders are used; when you click them to activate the borders,
you need to go to the options in the Type area and select the
kind of border you wish to use.

If you wish to use a border color other than the default black,
you also need to go to the Color field to select a different color.

To remove a border, click on it again and gray out the box
again.
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Field Description

Type After clicking on the portion of the cell (top, bottom, left or
right) that you wish to apply a border to, you must then select
the type of border you wish to use. The options are visually
represented, from hairline to thick solid borders, and also
dotted/broken borders.

Color After clicking on the portion of the cell (top, bottom, left or
right) that you wish to apply a border to, you must then select
the Type and the Color of the border you wish to use. This
field is used to select the border color. Use the drop-down box
to choose your color, or leave it as the default black.

The Align Tab
This tab gives you options for aligning the text for your selected cell(s).
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The following table describes the fields on this tab.

Field Description

Horizontal This affects the alignment of the cells' contents horizontally;
therefore, your options are to have your text aligned to the left
margin of the cell, the right margin, or centered.

Or, select the standard alignment. This will cause text fields to
be left-aligned and amount fields to be right-aligned, as is the
standard for financial information.

NOTE: You can also choose your alignment preferences using
the buttons on the toolbar, or by right-clicking and selecting
your alignment preferences from the pop-up menu.

Vertical Changes the alignment of the content in the cells vertically.
You can center your contents to the top of the cell, the bottom,
or in the middle. Standard alignment is the same thing as top
alignment.

NOTE: The effects of vertical alignment changes will only be
really evident if you have cells that wrap to more than one
line, or if you've changed the height of the cells in that row.

Wrap Text Click this option on if you want the text in cells to wrap to the
next line, in the event that all of the text doesn't fit onto one
line. If you don't want wrapping to occur, then leave this
option off.

Allow Enter Click this option if you want to be able to put a hard-line
return into a cell; that is, you want to be able to press Enter in
a cell and continue on with more text on the next lines.

The default is to leave this option off. If you don't turn this
option on, the spreadsheet will operate in the typical manner,
where pressing Enter moves you to the next cell.

Auto Size Turn this option on if you want the cells to be automatically
sized to fit the contents of the cell on one line.
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The Format Tab
This tab allows you to set the default format for the selected cell(s). For example, if
you have selected cells that contain dates, you can choose a specific format to display
those dates (DD-MMM-YY, etc.).

The following table explains the fields on this tab in greater detail.

Field Description

Format Type Select the type of content in the selected cell(s). Default is the
standard; it assumes the proper format from the Adagio
database for that field type (such as Dollars for an amount
field).

You can change the format, however, by selecting any other
format option from this list.

NOTE: You can also change the format of any cell to a
currency, percent, or comma format very quickly. To apply any
of these formats quickly, select the cell(s) of interest, then
right-click. Select the desired format (either Currency, Percent,
or Comma) from the pop-up menu, and the cell format will be
changed.
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Field Description

Precision For amount and other numeric fields, you can choose the
number of decimal places you wish to display. Type a number
between 0 and 23 here to indicate the number of decimal places.
If you leave this blank, the default will be accepted, such as 2
decimal places for an amount field.

NOTE: You can also change the number of decimal places for a
field by one digit at a time, by selecting the cell(s) you wish to
change and right-clicking. On the pop-up menu, select the
Increase Decimal or Decrease Decimal options.

Example Displays an example, to the precision specified, of how the
number, date, text will display within the view.

The Based On Tab
The list on the Based On tab displays the Styles you've created (or the defaults that
came with GridView). You can select a style which will be the basis for the
formatting of the selected cell(s). Then, anything you change in the other tabs of the
Cells window will be added to or modified from that style's original settings. Or, if
you want to apply a style and use its exact settings, select the style here, click OK
and ignore the additional tabs in the Cells window. (Refer to Working with Styles later
in this chapter for more information.)
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If you are creating a cell format that is similar to an existing style,
selecting that existing style in this tab will speed up the process.
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Conditional Row Formatting

The Row Formats button gives you the ability to set up conditional formatting for
rows. This may be useful to draw your attention to 'exceptions'. For example, you
might want a customer list to show highlighted in red only those customers who
have exceeded their credit limit or who have an outstanding balance in excess of
$5000.00.

Row Formats can also be attached to filters (see page 2-24 for more information).

To use the button or the Row Format dropdown, you may need to
first reset your “File” toolbar. To do so, select Customize from the
View menu. Click on the File option to select it. (Don’t remove the
checkmark beside it, however.) Then click the Reset button to the
right, and click OK to close this window. The Row Formatting
button will be added to your toolbar.

Setting Up a Style for Conditional Formatting
If you haven’t already got a style in your style list that you’d like to use for the
conditional formatting you’re about to set up, go to Format | Styles and create an
appropriate style. For instance, you could create a style called OverCredit which
displays text in bold and in red for each case of a customer whose balance
outstanding has exceeded their credit limit. See the “Working with Styles” section
later in this chapter for more information.
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Applying Formatting to Rows
When you click the Row Formats button, the following window appears:

You may select to create a New Row Format or to Edit, Duplicate or Remove and
existing Row Format listed to the left of the buttons. Additionally, you might Import
the Row Format condition from a text file or to Export it to a text file.

Clicking the New button opens the following window:

This window is very similar to the Filter window. You will want to provide a name
for the Row Format that will display in the Row Format dropdown in the toolbar.
On the left side, you have several trees to work with. To add any element from a tree
to the conditional formatting window on the right, just double-click it.
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Field Description

Fields The Field tree view lists all of the fields in the table you
selected for this View, allowing you to set your
conditional formatting options based on any field in the
table. Select the field(s) to be used for the conditional
formatting here.

Selected Fields This tree lists all fields on the current View. The list will
either be presented in the order they appear on the
report or in alphabetical order, if that option was
selected when defining the View.

Comparisons Use these fields to create the conditional formatting for
the field(s) you selected earlier. Comaprisons are
created in the standard way, using a set of criterion such
as "greater than or equal to" combined with a specific
{Field Name} or value.

For example, if you wanted to highlight rows for
customers whose outstanding balance exceeded their
credit limit, you would first select Balance Outstanding
from the Fields tree, then enter your > (greater than)
comparison operator from this tree, and then return to
the Fields list to select Credit Limit.

Operations This tree lists all Operators that may be used when
setting up conditions for your row formatting.

Functions This tree lists all Functions available when defining a
your row formatting conditions. A complete list of
functions and their purposes can be found in the Help
file.

Styles This tree displays a list of all of the styles you have set
up, and allows you to select a style that should be
applied to rows that meet your conditions.

NOTE: Global Styles created within other Adagio modules
will also appear in this window. The Automatic Styles from
the Adagio master record may be used within a view by
enabling the Auto Styles button in the Font toolbar. These
styles do ot require conditional row formatting.
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When you set up your formatting conditions such as our example of highlighting
customers whose Balance Outstanding exceeds their Credit Limit, your conditional
statement will appear to the right as in this screen sample:

When you click OK, your Row Formatting criteria will be saved. If necessary, click
the red R button in ther toolbar to enable Row Formatting (i.e. so the button is not
greyed out). Then, select the Row Format condition you wish to apply from the
dropdown. (If you do not see this button in your toolbar, you will need to Reset your
toolbars within View | Customize.)
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You may need to reformat the “numeric columns” after the first
time you Refresh the View, but the formatting will remain from
that point onward.

As well, when you select a row for which Row Formatting has been applied, a
Tooltip displays the format definition:

To edit the Row Format definition, either right click on the row and select Edit Row
Format from the context menu or select Edit | Row Format from the menu.
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Working with Styles

If you have worked with styles in other Windows products, such as Microsoft Word
or any desk-top publishing applications, you will be familiar with how styles work.

If not, styles are used to speed up formatting work. You can create a style and save
your cell formatting options (such as font, color, and border options) for that style,
and then change a cell's entire formatting by simply selecting that style for the cell.
This saves you the time of selecting all of those formatting preferences each time you
want a cell to look a certain way.

For example, you might create a column heading style which:

• sets the cell's background color to gray;
• sets the font size to 10 pt.;
• makes the text bold;
• aligns the text to the bottom of the cell vertically; and
• center-aligns the text horizontally.

Then, each time you format a cell and use the Based On tab to apply the column
heading style to a cell or group of cells, all of the formatting listed above will be
automatically applied to the selected cell(s).

Styles also allow you to quickly change the formatting of any cells that have already
had a certain style applied to them all at once. If you change the default "Column
Heading" style that comes with GridView, for example, then you will see that the
column headings in the View you're working with will all change automatically.

Apart from GridView’s default styles, styles are saved with individual Views, so if
you change or create a style in one spreadsheet, those changes will not be reflected in
other Views.

As well, the Automatic Styles from the Adagio master record (eg. vendor, customer,
item record, etc.) may be seen within a view by enabling the Auto Styles button in
the Font toolbar.
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Creating, Modifying, or Deleting Styles
You can modify GridView's default styles or create new ones by calling up the Styles
window. To do so, select Styles from the Format menu. The Styles window will
open.

This window contains a list of the existing styles. Global Styles created within other
Adagio modules will also appear in this window. The Automatic Styles from the
Adagio master record may be used within a view by enabling the Auto Styles button
in the Font toolbar.

Auto Styles button

To modify an existing style, select it in the list by clicking it once, and then click the
Change button.

When you modify a style, you are taken to the Cells window, where you can make
your desired changes on any of the tabs.

To remove an existing style, select it in the list and click the Remove button.
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To add a new style, type the name you wish to use for the new style in the blank
Name field and then click the Add button. When you click Add, you can then set the
style formatting using the options discussed in Changing Cell Formatting earlier in this
chapter.

The Save as default checkbox allows you to save this style list (and the formatting
for each style in the list) as your default style list, to be used in all Views.
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Adagio GridView includes a feature which allows you to create a look-up table, the
data from which can then be used in Calculated Columns and in Filters. This feature
can be useful if you need to manipulate data in an unusual way and can’t use simple,
standard formulas to do so.

For example, let’s assume that you want to create a View based on Adagio
SalesAnalysis data; however, rather than basing the commission rate on the
salesperson, as would be standard in Adagio SalesAnalysis, you wish to use the
customer ID to determine the commission rate. In addition, you wish to calculate
commission only if the invoice has been paid.

Because of the way commissions are normally set up, you would be unable to do this
in a standard View. However, with Named Items, you can set up a look-up that
equates a certain commission rate with each customer, and then use that commission
rate in your “commission paid” Calculated Columns.

The following sections will explain how to set up Named Item files for cases such as
this.
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Creating a Named Item File

You can create a Named Item file in one of two ways. First, Adagio GridView’s “Edit
Items” function provides a straightforward interface for loading and saving Named
Item Files, and adding, editing and deleting items within those files. Alternatively,
you can create a text file yourself and save it with the extension “.GVNames”.

Using the Edit Item Function
To use Adagio GridView’s Named Item file interface, simply press F3 or select
Named Items from the Edit menu. The following window appears if the file wasn't
saved using the Save with view option turned on:

Creating a File from Scratch
If you want to create a new file from scratch, you can start by adding items. Click the
New Item button.
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In the window that appears, enter your first item Name and its corresponding Value.
In the example we suggested earlier, where a commission is dependent not on the
salesperson but on the customer, you would enter a customer number as the Name
and the appropriate commission rate for that customer in the Value field. Click OK to
save the new item.

Repeat this process for each item you want to add to the file.

If you need to edit or delete an item from the file, you can select it from the Name
drop-down box and then click either the Edit Item or Delete Item button.

When you’re finished working with the items you want to include in this file, click
the Save File button and enter a filename. Adagio GridView requires the file
extension “.GVNames”, so simply enter a file prefix and click Save and the file will
be saved with the correct extension. The file is loaded at the same time that the view
is opened.

Or, you might turn on the Save with view option instead. When this option is
turned on, the Load File... button, Save File ... button and Current File field are
hidden. The Named Item list is saved with the same location and name as the
current View; although its extension will be ".GVNames". As a result, if no /n
parameter specifying another Named Item filename exists on the GridView shortcut,
the file having the same name as the view is loaded at the same time that the view is
opened. (See page 1-3 for more information about Command Line Parameters.)

Creating a Text File
If you will be including a large number of items in a Named Item file, you may find it
faster to create a file in a text editor and save it with the appropriate .GVNames file
extension.

The Named Item files are straightforward text files which begin with the standard
first line:

[NamedItems]

and then list one Name and one Value per line, beginning each line with a space, like
this:

[NamedItems]
BCS01=4.5
CAP01=4
PAC01=2

(This example displays customer numbers and commission rates as the names and
values.)

Creating a Named Item File
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You can also include comment lines in your file by starting the line with two forward
slashes, such as this:

// This is a comment line.

When you’re finished creating the file, save it with the .GVNames file extension, and
you can then load it into Adagio GridView.

Using Includes in Your Text File

Your text file can also have an “Include” section. This is simply a feature that
provides a drive and path to another named items file, which then get included in
the named items file when you load it into Adagio GridView.

This is a useful feature if there are certain named items you frequently use. With the
“include” feature, you can create one single file for those frequently-used named
items, and then simply refer to, or “call” that file, in other named item files. That
way, if anything changes in the frequently-used file, you only have to enter those
items in one place, and make changes to them in one place.

The Include file should be a .txt file, such as
C:\SOFTRAK\DATA\SALESPERSONS.TXT. It will look like any other named items
file, such as:

[NamedItems]
BS=Brian Smith
CH=Carl Hillar
RD=Rachel Doyle

Once that file has been created, it can be included in any other Named Items file,
using the [INCLUDE] line heading. For example:

[NamedItems]
BCS01=4.5
CAP01=4
PAC01=2

[Include]
C:\SOFTRAK\DATA\SALESPERSONS.TXT

The [NAMEDITEMS] and [INCLUDE] sections can appear in any order and can be
interspersed.

As with any other Named Items file, a Named Items file that is created with the
[INCLUDE] section must be saved with the file extension .GVNames. You can then
load it into Adagio GridView.

Creating a Named Item File
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Loading a Named Item File

Before you can use Named Item values in your Calculated Columns and Filters, you
must first load it. To do this, press F3 or select Named Items from the Edit menu.
Select the file, click the Load File button in the window that appears and click OK.
The file will be loaded.

If you need to modify anything in the file before you begin using its values in your
View, you can use the add, edit, and delete options to make any changes necessary.
Otherwise, just click OK to exit the Edit Items window. The items included in this file
can now be used in your Calculated Columns and Filters.

Named Item list files that have the same location and filename as
the current View and an extension of .GVNames are automatically
loaded when the view is opened, if no other Named Item file is
specified in the Command Line Parameters of the shortcut used to
run GridView.. (Refer to page 1-3 for more information about
Command Line Parameters.)

Loading a Named Item File
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Using the Named Items

When you have loaded a Named Item file, you can then use the values in that file in
your Filters and your Calculated Columns, via the GETNAMEDITEM() function.
This function is described in the Query Functions section on page 3-166 of Appendix
C. However, it is important to note the following:

The value that is returned by the GetNamed Item function is always a string. If
you need to use that value as a number or a date or something else, then you must
convert it. The Formulas & Functions section of the Help file explains this in detail.

Using the Named Items
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Setting a Default File

Once you have created and Named Item files, you can also set a default Named Item
File to be used as your standard Named Item File in any View. As with any default,
this can be changed for each View, but if you commonly use a particular Named Item
File, setting the default may save you time in creating other Views.

To set a default file, select Defaults from the Edit menu. The Defaults window will
appear with the Named Item File field at the bottom.s

Click the Browse button to the right of the Named Item File field to locate and select
your default file. When you’re done, click OK to exit this screen and your default
Named Item file will be saved.

Setting a Default File
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Auto-Loading Named Items

As discussed in the Adagio Fundamentals manual, Adagio allows you to set
“Command Line Parameters” for your desktop icon, so that when you start up an
Adagio module you don’t need to enter your username and password each time, or
the data location you usually work with, and so forth.

If you want to use the Command Line Parameters to also automatically load a
Named Item file each time you start up Adagio GridView, you can set an “/N”
command line parameter to do this.

In the command line, simply enter “/n” followed by the Named Item file location
and file name, such as:

...GVWIN.EXE /c /uSYS /pSYS
/n”C:\SOFTRAK\GVWIN\NamedItems\Sample.GVNames”

Auto-Loading Named Items
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Adagio GridView allows you flexible options for exporting data to spreadsheets and
even web pages! We’ll show you how to use the export options in this chapter.

If the security of your data is a concern, you can prevent users from
exporting data. To do so, go to the View Defaults window and turn
off the Allow export option.
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Exporting to Microsoft Excel

You can export a View's data to Excel for further use. To do so, select File | Export
to | Excel Direct from the menu (or click the Excel Direct button in the toolbar).
Using Excel Direct maintains the column headings from your View in the Excel file
created.

Excel Direct
Use this option if you want to maintain column headings in your Excel file.

Once you’ve opened the View whose data you wish to export, select Export to |
Excel Direct from the File menu. You'll be prompted for the location and file name
for the Excel (.xls) file. Select the appropriate drive, directory, and file name and click
Save.

Additionally, you may export an entire Workspace's data to Excel by selecting File |
Export to | xDirect Workspace, or holding the Shift key on the keyboard and
clicking the Excel Direct button in the toolbar.

Hidden cell data is not exported to Excel.

A new instance of Microsoft Excel will be opened and the current GridView data will
be written to the spreadsheet. The column titles are exported as bold text and the
spreadsheet is formatted to match the columns in GridView.

Hidden cell data is not exported to Excel.

The Excel Direct process can be cancelled at any time by pressing Escape.

Exporting to Microsoft Excel
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Exporting to HTML or XML

You can export your View's data to HTML format very easily. To do so, simply select
Export to | HTML from the File menu. The Select HTML Attributes window will
appear.

The following table describes the fields on this window.

Field Description

Display cell borders Selecting this option will result in cell borders being
added to your HTML table, using an HTML border
width of "1".

Display row numbers If you want your table to include a column at the left
edge of the table which indicates the row numbers,
turn this checkbox on.

Display column titles If you want your table to include the column titles,
turn this option on. Usually, you will want to use this
option.

Click OK when you've set your export preferences. You'll be prompted for the
location and file name for the HTML (.htm or .html) file. Select the appropriate drive,
directory, and file name and click Save. The data will be exported to an HTML file.
Note that all of your formatting, such as the use of color, different fonts, gray
shading, and so forth, will be exported as well.

Your exported data is now ready to be uploaded to a web site or opened in any web
browser or HTML editor.

Exporting to HTML or XML
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To export a view to XML, select Export to | XML from the File menu. Specify the
filename to be used and the folder location the view will be exported to.

Additionally, you may choose to Export | XML Data Only. Selecting this option
exports all data in the view, whether hidden or not, without formatting.

Exporting to HTML or XML
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I can’t edit the fields displayed in my View.

You may have forgotten to put /c on the shortcut command line, or you didn't start
GridView by clicking on the correct shortcut. See the Adagio Fundamentals manual for
more information on using Command Line Parameters.

Nothing happens when I click on GridView to start it.

If you are using a workstation connected to a network, make sure you have
performed a Workstation Install before trying to use GridView. Some components
need to be installed on the local machine. See the Adagio Fundamentals manual for
more information on workstation installations.

I can’t rearrange the columns in the grid.

You may not be releasing the mouse button after selecting the column. Click once to
select the column and release the mouse. Then click the column heading again and
hold the left mouse button down while you drag the column to the desired position.
A thin red line will mark where the column will be moved to.

I can’t get dates to work in a Filter or Calculated Column.

You must use the DATE(Year,Month,Day) function in your date comparison. Year is
a value between 0 and 199 for 1900 to 2099 or you may use a four digit year between
1900 and 2099. An example would be {Last Maintenance Date} = DATE(101,07,19 )
or {Last Maintenance Date} = DATE(2001,07,19 ). In this case the date is July 19th,
2001.

Alternatively, you may use the DATEVALUE(String) function. These functions are
explained in the Date/Time Functions section of the GridView Help file.
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I have specified the subdirectory on the command line, but it is not being recognized.

Make sure that the path does not contain an embedded space. If it does, then you
need to enclose the entire path in quotation marks. For example, if your data is
stored in C:\My Data\Accounting, then the correct way to specify this on the
command line is /d"C:\My Data\Accounting". See the Adagio Fundamentals manual
for more information on using Command Line Parameters.

The sum isn't correct when I select numeric fields and right mouse click.

You must select all the cells you want summed, before you right mouse click. It is
easy to forget and simply right mouse click on the last cell in the sum. Unless it has
been selected first, it will not be included in the displayed total.

I can’t get IF THEN ELSE to work in a Filter or Calculated Column.

GridView uses the IF ( Expression,
Value if Expression is TRUE,
Value if Expression is FALSE) form for this function.

This is consistent with other spreadsheets. An example is shown in Logical Functions
in the GridView Help file.

I can’t get AND to work in a Filter or Calculated Column.

GridView uses the AND (Expression List) form for this function.

This is consistent with other spreadsheets. An example is shown in Logical Functions
in the GridView Help file.

I can’t get OR to work in a Filter or Calculated Column.

GridView uses the OR (Expression List) form for this function.

This is consistent with other spreadsheets. An example is shown in Logical Functions
in the GridView Help file.

Common Questions
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This chapter contains a list of tips and tricks that will help you to save time when
using Adagio GridView. We’ve designed the program so that the tasks that you
might do most often are quick and easy to execute.

Good to Know

Quick Sum
You can quickly find the sum of a set of numbers on a View by selecting the cells
using Shift+Click or Ctrl+Click and then pressing the right mouse button. The sum
of the numbers is displayed on the pop-up menu.

Record View
Sometimes, it is more convenient to view a single record at a time. GridView allows
you to "flip" back and forth between a normal View and a Record View of
information. By pressing F7, or clicking on the Record View button, you can easily
inspect a single record.

Hiding Columns from Display
The Hide and Unhide options work the same in GridView as in any spreadsheet
application. Just click Hide to remove it from the View. You can still refer to it in
formulas and so forth; it just will not display.
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To add it back to the display and view it again, simply select both columns on either
side of it, right-click, and select Unhide. You may multi-select colums to Hide within
the Edit Definition and Calculated Columns functions also.

Hiding Columns for Printing
You can format a column not to print. It will display light blue on the screen when it
is set to hide when printed. To do this, select the column by clicking the column title;
then click the right mouse button and select "Hide when printed" from the pop-up
menu.

Rename Columns
The Rename feature lets you change a column’s title or heading for printing or
viewing. To rename a column, select the column and right-click; then select Rename.
When prompted, type in the new name. You are not allowed to have duplicate
column names within the same view.

Format Columns
If you want to change the formatting for an entire column, you can easily do so by
selecting the column, right-clicking, and choosing the Add Formatting... option from
the pop-up menu. This will call up a standard Formatting window with tabs to allow
you to set the font, alignment, and more.

To quickly remove formatting from a column, select the column and right-click
again, and this time select Clear Formatting... instead. All formatting you previously
set will be removed and the default formatting will be applied.

Width of Columns and Height of Rows
You can change the width of columns or the height of rows by selecting the column
or row (just click in the gray column or row title area to select it) and then moving
your cursor over to the border of the column or row. Your cursor will change to a line
with a double-arrow; just click and drag the border to the right or left to adjust a
column's width, or up or down to adjust a row's height.

Zoom
You can make the View larger or smaller by zooming in or out using the zoom
buttons on the toolbar.

Tips and Tricks
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Or, use the Zoom In and Zoom Out commands on the View menu, or by pressing
F11 or F12 respectively. You can also restore the View to its original size by pressing
Alt+F12 or using the 100% button on the toolbar:

Also, when using some mice with wheels, under Windows 2000 or XP, you can use
Ctrl+wheel to zoom in and out.

Good to Know
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GridView Keyboard Shortcuts

Most menu choices are available using shortcut keys. It’s a good idea to scan this list
to find any of the tasks that you do often. If you take the time to learn the shortcut
keys for these tasks, you can save a lot of time, and use GridView like a pro!

File Menu Shortcuts
File New Ctrl+N

Open Ctrl+O

Save Ctrl+S

Save All Ctrl+E

Open Workspace Shift+Ctrl+O

Save Workspace Shift+Ctrl+S

Print Ctrl+P

Print Preview Shift+Ctrl+P

Exit Alt+F4

Edit Menu Shortcuts
Edit Find Ctrl+F

Find again Shift+Ctrl+F

Defaults F2

Named Items F3

Definition F4

Filters F6

Calculated Columns F8

Row Formats Shift+F8

Sort Sequences Ctrl+F6

Column link F10

GridView Keyboard Shortcuts
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Format Menu Shortcuts
Format Row Formats Shift+F8

View Menu Shortcuts
View By rows F7

Zoom in F11

Zoom out F12

100% Alt+F12

Refresh data F5, F9

Summarize Shift+F5

Window Menu Shortcuts
Window Tile Horizontal Ctrl+T

GridView Keyboard Shortcuts
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Customizing the Window

You can customize the appearance and contents of your GridView window and
toolbars by selecting Customize from the View menu. When you select this
command, the Customize window appears. This window has two tabs: Toolbars and
Commands.

The Toolbars Tab
The Toolbars tab allows you to select which toolbars you want to display on screen.
The available toolbars are listed on the left hand side. Click a checkmark next to the
toolbars you want to display in the GridView main window.

If you wish to have small yellow text pop-up "tips" appear when your mouse is over
a particular button on the toolbar, turn the Show Tooltips option on. This may be
useful when learning the GridView buttons, because the tips explain the button's
function. For example, when your mouse is over the File Open button, a little yellow
box with the word "Open" will appear.

Customizing the Window
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Turn the Cool Look checkbox on if you wish to remove the three-dimensional
"button" look from the toolbars. (To have the 3-D "button" look, turn this option off).

With new releases of Adagio GridView, you may occasionally need to reset your
“File” toolbar. To do so, click the Reset button in this tab, and click OK to close this
window.

The Commands Tab
The Commands tab allows you to select which buttons are available on the GridView
toolbars.

This list on the left hand side shows you categories of buttons that you can add to
your toolbar. Select the category that contains the button you wish to add to a
toolbar, and the buttons for that category will be displayed to the right.

To add a button to a toolbar, click on the button and then hold the mouse button
down and drag it to the position where you want it to appear on the toolbars at the
top of the screen. Release the mouse button, and the new button will be added to the
toolbar.

Customizing the Window
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In addition to adding buttons to a toolbar, you can also remove buttons that you
don’t use. To do so, with the Commands tab open, select the button you wish to
remove from the toolbar at the top of the window. Hold the mouse button down, and
drag the mouse down to the "Buttons" area in the Commands tab. Release the mouse
button. The button will be removed from the toolbar.

Sample Views

GridView ships with several useful Views for each Adagio module. These are
especially useful as templates that you can edit and customize to suit your
organization’s needs.

Below is a list of some sample Views that you may find particularly useful. We'd
recommend that you load these and other sample Views and see which would be
useful in your organization.

Balancesheet.gv
Simple 12 period Balance Sheet. The View is filtered on Account Type so as not to
show the Income/Expense Accounts.

IncomeSheet.gv
Simple 12 period Income Statement. The View is filtered on Account Type so as to
only show the Income/Expense Accounts.

Customers.gv
Customer list linked to OrderHeaders.gv.

There are many other sample Views included with the sample data. Please take the
time to look through all of them and revise them to fit your needs.

Sample Views
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This appendix lists the available GridView functions, with a brief description of their
purpose. For details, parameters, and examples of these functions, please see the
GridView Help file. You can access the Help file at any time through the Help menu
or by pressing F1.
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Date and Time Functions

Function Description

BEGINMONTH() This function returns the date value corresponding to first
day of the current month.

BEGINWEEK() This function returns the date value corresponding to first
day of the current week. The first day of the week is
Sunday.

BEGINYEAR() This function returns the date value corresponding to first
day of the current year.

DATE(Y, M, D) or
DATE(YYYY, M, D)

This function returns the date value corresponding to year
Y+1900, month M, and date D. Y must be in the range 0 to
199 (representing 1900-2099). It is less confusing if you use
the YYYY form for the year. In this case the YYYY must be
a value between 1900 and 2099.

DATEEND("SP" [,"C" |
"F"])

Returns the end of period date based on the Financial
Reporter spec code and the session date used to log into
GridView, which may pertain to either the Calendar or
Fiscal year (Calendar is the default). The date is formatted
as a Julien date (number) unless the column as been
formatted as a different date format. Suggested Financial
Reporter spec codes might be M, Q, S, Y. Prior year spec
codes may be used by precedfing the spec code with {1} or
{2} codes (eg. one year ago, two years ago).

NOTE: The session date may be overridden by the Run Date in
GridView. If creating a new calculated column using the "F"
option, you may be unable to Verify the formula if the date falls
outside of any of the fiscal calendars currently stored in Ledger.
If an existing column uses the "F" option, Error! will be
returned if the date falls outside of any of the fiscal calendars
currently stored in Ledger.

Date and Time Functions
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Function Description

DATEIN Used to test for the existence of the date stored in the Date
calculated column within the range defined by the
StartDate and EndDate calculated columns. Returns 1 if
the date exists within the range; otherwise, returns 0.
Result may vary if "F" option is used within StartDate and
EndDate.

DATESTART("SP" [,"C"
| "F"])

Returns the start of period date based on the Financial
Reporter spec code and the session date used to log into
GridView, which may pertain to either the Calendar or
Fiscal year (Calendar is the default). The date is formatted
as a Julien date (number) unless the column as been
formatted as a different date format. Suggested Financial
Reporter spec codes might be M, Q, S, Y. Prior year spec
codes may be used by precedfing the spec code with {1} or
{2} codes (eg. one year ago, two years ago).

NOTE: The session date may be overridden by the Run Date in
GridView. If creating a new calculated column using the "F"
option, you may be unable to Verify the formula if the date falls
outside of any of the fiscal calendars currently stored in Ledger.
If an existing column uses the "F" option, Error! will be
returned if the date falls outside of any of the fiscal calendars
currently stored in Ledger.

DATESTRING
(DATE [, “Optional
Format String”])

This function returns a date formatted as text based on the
optional parameters passed to the function.

Date and Time Functions
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Function Description

DATEVALUE(S) This function returns the corresponding date value for a
given string S. It interprets the data in the following
formats:

� MM/DD/YY
� DD-MMM-YY
� MMM-YY (assumes the first of the month)
� DD.MM.YY

In all formats, the year may be omitted, in which case it
defaults to the current year. The year may be given as 2 or
4 digits. A two year digit assumes the 20th century. In the
above formats, the month (MMM) is case insensitive and
may be either the standard 3 letter abbreviation or the full
name of the month.

DAY(DT) This function returns the day of the month component of
the date/time value DT.

EDATE(S, M) This function returns a date/time value representing the
date M months after S if M is positive, and M months
previous to S if M is negative. The date returned will be on
the same day of the month as S.

EOMONTH(S, M) A date/time value representing the date M months after S,
if M is positive, and M months before S, if M is negative.
The date returned will be on the last day of the month.

FISCALSTART() This function returns the date value corresponding to first
day of the current fiscal year. The Fiscal Start is defined on
the GridView Default screen.

HOUR(DT) This function returns the hours (0 - 23, where 0 represents
midnight) component of the date/time value DT.

MINUTE(DT) This function returns the minutes (0 to 60) component of
the date/time value DT.

MONTH(DT) This function returns the months component of the
date/time value DT.

Date and Time Functions
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Function Description

NOW( ) This function returns the date/time value corresponding to
the current system time and date.

TIME(H, M, S) Returns the time value represented as a fraction of a day,
starting at midnight. H must be between 0 and 23, and M
and S must be between 0 and 59.

TIMEVALUE(S) Returns the corresponding time value for a given string
value S. The function interprets the times specified in the
following formats:

� HH:MM:SS AM or PM — (1 <= HH <= 12)
� HH:MM:SS — (0 <= HH <= 23)
� HH.MM.SS — (0 <= HH <= 23)
� HH,MM,SS — (0 <= HH <= 23)
� HHhMMmSSs — (0 <= HH <= 23)

The first format is the international 12-hour AM/PM time
format. All others are international 24-hour time formats.
In all formats the seconds (SS) may be omitted, in which
case they default to 00. In all formats the hours may be
specified with 1 or 2 digits, while the minutes (MM) and
seconds (SS) must be 2 digits. The following are equivalent:
TIMEVALUE("12:55:00 AM") TIMEVALUE("12:55 am")
TIMEVALUE("00:55:00") TIMEVALUE("00:55")
TIMEVALUE("00, 55, 00") TIMEVALUE("0.55.00")
TIMEVALUE("0h55m00s") The result is 0.038194444

TODAY( ) Returns the date value corresponding to the current system
date.

WEEKDAY(D) Returns an integer representing the day of the week on
which the day D falls. 1 is Sunday, 7 is Saturday.

YEAR(DT) Returns the years component of the date/time value DT,
where 1900 = 0 or 2008 = 108.

YEARFRAC(S, E[, B]) Returns the year fraction representing the number of whole
days between S (start date) and E (end date). This function
is useful in calculating the percent of benefit or obligation
to assign a specific period.

Date and Time Functions
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Function Description

YEARL(DT) Returns the full year component of the date/time value
DT, eg year 1900 or 2008.

Date and Time Functions
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Financial Functions

Function Description

ACCRINT(I, Ft, S, R, P, F [, B]) This function returns the accrued interest for a
security that pays periodic interest. Accrued interest
is the amount the buyer must compensate the seller
for the portion of the next coupon interest payment
the seller has earned but will not receive from the
issuer.

ACCRINTM(I, S, R, P [, B]) This function returns the accrued interest for a
security that pays interest at maturity.

CTERM(R, FV, PV) This function calculates the number of
compounding periods required for an investment of
PV to reach a value of FV at the given interest rate
R.

CUMIPMT(R, N, P, S, E, T) This function returns the cumulative interest paid
between S (the start) and E (the end) on a loan.
Make sure that you are consistent about the units
used for specifying R and N. For example, for a
4-year loan with 10% annual interest rate, use
10%/12 for R and 412 for N)

CUMPRINC(R, N, P, S, E, T) This function returns the cumulative principal paid
between S (the start) and E (the end) on a loan.
Make sure that you are consistent about the units
used for specifying R and N. (For example, for a
4-year loan with 10% annual interest rate, use
10%/12 for R and 412 for N)

DB(C, S, L, N, M) This function returns the fixed-declining real
depreciation of an asset for a specified period.

DDB(C, S, L, P) This function returns the double-declining
depreciation allowance given cost C, salvage value
S, allowable life L, and N number of depreciation
periods.

Financial Functions
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Function Description

EFFECT(R, P) This function returns the effective annual interest
rate.

FV(P, R, N) This function returns the future value of an annuity
given periodic payment P, interest rate R, and N
number of periods.

FVSCHEDULE(P, R) This function returns the future value of an initial
principal after compounding by a series of interest
rates.

GLCALC(SC,Y,P,A,D[v]) Calculates the value for the requested spec code for
the requested entry, where the Account and Data
fields exist in the view or are manually entered
(leading spaces required). This may be any of the
specification codes from the Account Data tree in
the Adagio Financial Reporter. Popular codes
include BAL (Balance), Y (YTD), B (Total budget),
BY (Budget YTD), M (Current Period).

Financial Functions
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Function Description

HLOOKUP(X, R, N) This function returns the value of a cell found by
performing a horizontal table lookup. HLOOKUP
searches the first row (known as the index row) in
the range R for the numeric or string value which
"matches" X, and returns the value N rows beneath
the matching cell. If X is a string value, an exact
match must be found or an error is returned.

If X is a numeric value, the index row must contain
numeric values, sorted in ascending order, and the
matching column is determined by the following
rules:

� Strings and blank cells in the index row are
ignored.

� If the first value in the index row is greater than
X, an error is returned.

� Searching stops when a numeric value which is
greater than or equal to X is found in the index
row. If the value found is greater than X, the
preceding column is the matching column.

� If there are no numeric values in the index row
which are greater than or equal to X, the last
column in R is considered to be the matching
column.

INCLUDEAMOUNT ("SP"
[,"C" | "F"])

Used to test for the existence of the date started in
the Date calculated column within the range
defined. Returns the value of {Number} if date
exists within the range; otherwise returns 0. Result
may vary if "F" option is used (see DATEEND
and/or DATESTART). Suggested Financial
Reporter spec codes might be M, Q, S, Y. Prior year
spec codes may be used by preceding the spec code
with {1} or {2} codes (eg. one year ago, two years
ago).

IPMT(R, P, NP, PV, FV, [T]) This function returns the interest payment for a
specified period for an loan or investment based on
periodic, constant payments and a constant interest
rate. Make sure that the units used for R and P are
consistent. For example, for a 5-year loan with 12%
annual interest, if you make payments monthly, use
12%/12 for (monthly) R and for NP.
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Function Description

IRR(G, F) This function returns the internal rate of return on
an investment given a set cash flows contained in
range F, and an initial "guess" G (usually 0). F must
contain at least two cash flow values. Negative cash
flows represent expenditures, and positive cash
flows represent income. Blanks and text are treated
as zeros.

MIRR(V, F, R) This function returns the Modified Internal Return
Rate for a range of periodic cash flows. Blanks and
text are treated as zeros.

NOMINAL(R, C) This function returns the nominal annual interest
rate for an effective interest rate R and the number
of compounding periods per year C.

PMT(PV, R, N) Returns the periodic payment for a loan, given
present value PV and interest rate R.

PPMT(R, P, NP, PV, FV[, T]) Returns the payment on the principal for a specific
period for an investment based on periodic,
constant payments and a constant interest rate.
Make sure the units used be R and NP are
consistent. For example, for a 5 year loan with 12%
annual interest, if you make payment monthly, use
12%/12 for (monthly) R and 512 for NP. If you
make annual payment on the same loan, use 12%
for R and 5 for NP.

PV(P, R, N) Returns the present value of an annuity given
periodic payment P, interest rate R and N number
of periods.

RATE(FV, PV, N) Returns the interest rate required to go from present
value PV to future value FV in N compounding
periods.

SYD(C, S, L, P) Returns the "sum-of-years-digits" depreciation
allowance given cost C, salvage value S, allowable
life L, and depreciation period P.
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Function Description

TERM(P, R, FV) Returns the number of payment periods for an
investment given the periodic payment P, the
interest rate R and future value FV.

VDB(C, S, L, S, E) Returns the depreciation of an asset between two
specific period using the fixed-declining balance
method.

XIRR(G, V, D) Returns the internal rate of return for a series of
cash flows (V) with variable intervals (D). V and D
must be one-dimensional ranges and have the same
size.

XNPV(R, V, D) Returns the net present value for a series of cash
flows (V) with variable intervals (D). V and D must
be one-dimensional ranges and have the same size.

YIELD(S, M, R, PR, RD, F[, B]) Returns the yield at maturity of a security that pays
periodic interest. All dates must be entered as serial
date value.

YIELDMAT(S, M, I, R, PR[, B]) Returns the annual yield of a security which pays
interest at maturity. All dates must be expressed as
serial date values.
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Logical Functions

If you wish to include a double quote (“) in a string for comparison
or formula purposes, use the escape backslash to include it. For
example, to look for all item descriptions that contain the inch
symbol (”), you would use FIND(“\”",{Description},1)0.

Function Description

AND(argumentlist) This function returns 1 if all arguments are 1; 0 if any
argument is 0; otherwise -1 (unknown). The argument list
may be a series of {Field Names} or expressions.

FALSE( ) This function returns 0.

IF(X, T, F) This function returns the value of T if X evaluates to
non-zero, or F if X evaluates to zero.

NAND(argumentlist) This function returns 0 if all arguments are 1; 1 if any
argument is 0; otherwise -1 (unknown). The argument list
may be a series of {Field Names} or expressions.

NOR(argumentlist) This function returns 0 if any argument is 1; 1 if all
arguments are 0; otherwise -1 (unknown). The argument
list may be a series of {Field Names} or expressions.

NOT(X) This function returns 1 if X=0; 0 if X=1; otherwise -1
(unknown).

OR(argumentlist) This function returns 1 if any argument is 1; 0 if all
arguments are 0; otherwise -1 (unknown).

TRUE( ) Returns the value 1.
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Math Functions

Function Description

ABS(X) This function returns the absolute (positive) value of X.

CEIL(X) This function returns the smallest integer that is greater
than or equal to X.

FLOOR(X) This function returns the largest integer less than or
equal to X.

FRAC(X) This function returns the fractional portion of X.

INT(X) This function returns the integer portion of X.

MOD(X, Y) This function returns the remainder of X/Y with the
same sign as X. (This function is NOT modulus as
sometimes documented.)

MODULUS(X, Y) This function returns the modulus of X/Y.

PI( ) This function returns the value of the mathematical
symbol PI.

PRODUCT(argumentlist) Multiplies all the numeric elements of the argument list
together, ignoring empty and non-numeric values, and
returns the product.

ROUND(X, N) Returns X rounded to the number of decimal places
specified by N (when N is positive); it returns X rounded
to a whole number when N is negative.

SQRT(X) Returns the positive square root of X.

SUM(argumentlist) Returns the sum of its arguments. Blank cells and cells
containing strings are not counted.
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Function Description

VSUM(argumentlist) Returns the "visual sum" of its arguments. This function
differs from SUM in that it uses the precision and
rounding of the actual formatted values appearing in the
cells instead of the internal double-precision value of the
cell. This ensures that what you see is what you get when
calculating a sum.

Note: VSUM will only be recalculated when the cell
values of the references cells are changing. If you change
the format of the referenced cells but not the values, you
have to manually update the cell with the VSUM
formula, e.g. by editing it and adding a blank at the end.
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Statistical Functions

Function Description

AVG(argumentlist) Returns the average (arithmetic mean) of its arguments.
Blank cells and strings are ignored.

MAX(argumentlist) This function returns the maximum of its arguments.
Blank cells and cells containing strings are not counted.

MEDIAN(argumentlist) This function returns the median (middle value) of its
arguments. Blank cells and cells containing strings are
not counted.

MIN(argumentlist) This function returns the minimum of its arguments.
Blank cells and cells containing strings are not counted.

MODE(argumentlist) This function returns the mode, or most frequently
occurring datum, of all the arguments. Empty cells and
cells containing text are ignored.
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Text Functions

If you wish to include a double quote (“) in a string for comparison
or formula purposes, use the escape backslash to include it. For
example, to look for all item descriptions that contain the inch
symbol (”), you would use FIND(“\”",{Description},1)0.

Function Description

CHAR(N) This function returns the character represented by the
ASCII code N.

CHOOSE(N,
argumentlist)

This function returns the Nth argument from the
argument list, the first item in the argument list is in
position 1.

CLEAN(S) This function returns the string formed by removing all
non-printing characters from the string S.

CODE(S) This function returns the ASCII code for the first
character in string S.

COLUMNCONTAINS
("S1", "S2" [,N])

This function returns the count of the occurrences of
string S1 in string S2. Matching of S2 is case sensitive if
N is true, 1. 0 is returned if the string is not found.

NOTE: S1 must be the text string of the column name and not
a field name, eg. {Name}. The column name string is always
case sensitive.

CONCATENATE
(argumentlist)
or
STRCAT(argumentlist)

Returns the concatenation of all its arguments. For cell
arguments, the actual formatted contents of the cell are
used, even if the cell contains a numeric value. To add
text strings you may use the "&" operator.

COUNTSTR("S1", "S2"
[,N]

This function returns the count of the occurrences of
string S1 in string S2. Matching is case sensitive if N is
true, 1. 0 is returned if the string is not found.

EXACT(S1, S2) This function returns 1 if string S1 exactly matches string
S2; returns 0 otherwise.
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Function Description

FILEEXISTS(S) Used to test for the existence of a file. Returns 1 if full
pathname and file in string exist; otherwise returns 0.

FIND(S1, S2, N) This function returns the position of the first occurrence
of string S1 in string S2, starting the search at position N
in string S2. The first character in string S is at position
one (1). Zero (0) is returned if the string S1 was not
found.

FINDALL(S, list) Returns 1 if every one of item1 through itemN is found in
the string to search; otherwise, it returns 0. This is an
exact match function.

FINDANY(S, list) Returns 1 if any one of item1 to itemN is found in the
string to search; otherwise it returns 1. This is an exact
match function.

FINDCOUNT(S, list) Returns the number of items, item1 to itemN, found in
the string to search, or 0 if none. This is an exact match
function.

FULLFILENAME(S) Returns the string. Use instead of STRCAT when a "\" is
required in a string. Cannot be used with the 'Calculate
after refresh' option enabled and cannot be embedded in
other functions (eg. within an IF or FILEEXIST).

LEFT(S, N) This function returns the string composed of the leftmost
characters of string S. If N is greater than or equal to the
length of S, then the entire string S is returned.

LENGTH(S) This function returns the number of characters in string
S.

LOWER(S) This function returns the alphabetic string S converted to
lower-case characters.

MATCHALL(S, list) Returns 1 if every one of item1 through itemN is found in
the string to search; otherwise, it returns 0. This is an
fuzzy match function, where a result may be returned if
the match is close but not exact.
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Function Description

MATCHANY(S, list) Returns 1 if any one of item1 to itemN is found in the
string to search; otherwise it returns 1. This is an fuzzy
match function, where a result may be returned if the
match is close but not exact.

MATCHCOUNT(S, list) Returns the number of items, item1 to itemN, found in
the string to search, or 0 if none. This is an exact match
function.

METAPHONE(S) Returns up to a 4 character metaphone sequence of the
string.

MID(S, N1, N2) This function returns the string of length N2 that starts at
position N1 in string S. N1 is the position in the string
and must be greater than or equal to 1, and less than or
equal the length of S. N2 must be greater than or equal to
1. If N1+N2 is greater than the length of S, then the
substring starting at position N1 in S is returned. The first
character in string S is at position one (1).

MID(S, N1, N2) This function returns the string of length N2 that starts at
position N1 in string S. N1 is the position in the string
and must be greater than or equal to 1, and less than or
equal the length of S. N2 must be greater than or equal to
1. If N1+N2 is greater than the length of S, then the
substring starting at position N1 in S is returned. The first
character in string S is at position one (1).

PROPER(S) Returns the string S with the first letter of each word
capitalized.

REMOVEALL("S1", "S2") This function removes all occurrences of string S1 from
string S2. The function is not case sensitive.

REMOVEDUP("S1", "S2") This function removes duplicate occurrences of string S1
from string S2. The function is useful for removing
multiple blanks from a string.

REPEAT(S, N) Returns the string S repeated N times.
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Function Description

REPLACE(S1, N1, N2, S2) Returns the string formed by replacing the N2 characters
starting at position N1 in string S1 with string S2. The
first character in string S is at position one (1).

RIGHT(S, N) Returns the string composed of the rightmost N
characters of S. If N is greater than or equal to the length
of S, then the entire string S is returned.

SOUNDEX(S[, N]) Returns up to a 4 character Soundex of the string; if N is
provided and it is non-zero then the extended Soundex
result is returned as a number.

STRCAT(argumentlist)
or
CONCATENATE
(argumentlist)

Returns the concatenation of all its arguments. For cell
arguments, the actual formatted contents of the cell are
used, even if the cell contains a numeric value. To add
text strings you may use the "&" operator.

NOTE: Complications can arise in when a text data field
contains only numeric values. This might cause it to be read
as numbers. To ensure a data element is treated as text, make
sure the column is formatted as text and use STRCAT to place
an alphabetic character at the beginning of the field value. You
may need to adjust formulas relying on this field's values.

STRING(X, N) Returns the string representing the numeric value of X,
formatted to N decimal places, where N is in the range 0
to 15. The results are rounded.

STRLEN(argumentlist) Returns the total length of all the strings in its argument
list. It differs from LENGTH in that it can take multiple
arguments, but more significantly, it returns the length of
the formatted contents of a cell, even if it contains a
numeric argument.

TRIM(S) Returns the string formed by removing leading, trailing
and consecutive embedded spaces from string S.

UPPER(S) Returns the string S converted to uppercase characters.

VALUE(S) Returns the numeric value represented by string S, or 0 if
S does not represent A number.

Text Functions

Function List Page C-165



Query Functions

If you wish to include a double quote (“) in a string for comparison
or formula purposes, use the escape backslash to include it. For
example, to look for all item descriptions that contain the inch
symbol (”), you would use FIND(“\”",{Description},1)0.

All =QUERYxxx() functions take an optional third parameter that, if non-zero, results
in the query being executed once per load of a workspace or view. In this case, if you
want to change and answer supplied to a =QUERYxxx() function, the
view/workspace will need to be reloaded. This is useful in obtaining a time period
from a user while not requiring the entry to be made over and over for different
refreshes of the view. To assist in the development of views, any edit of a Calculated
Column or Filter will result in the =QUERYxxx() function being re-executed.

To use, a second parameter or default value must always be included in the
=QUERYxxx() formula. If not used, the second parameter may be optionally used
and the third parameter is always assumed to be zero; therefore, the filter will rerun
whenever the filter is loaded or the data refreshed.

To assist you in resetting your workspace queries that use the optional third
parameter, without having to reload the workspace, select the Reset Query

button and Refresh (F9) the view to reset the query.

Function Description

DATAFILENAME() Places the name of the file — that is, the Adagio data file,
such as ARCUST’R — on the view.

FILTERMOD() FILTERMOD() returns everything in the View Title after
the “+” sign. This is useful in isolating the value passed
from the parent View to the Linked View. Use the
LEFT(), MID() and RIGHT() functions to select the
information that might be useful in the Linked View.
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Function Description

FILTERNAME() This function can be used in a formula to see what filter
is active. It is generally used to change the contents of a
column based on which filter is being used. For example,
if you have two filters on an OrderEntry View, one for
viewing Invoices and one for Credit Notes, you could
then use the FilterName function to created a calculated
column that displays either the Invoice #, for the
Invoices filter, or the Credit Note #, for the Credit Notes
filter.

GETCODEDTEXT(S1) Use this function to translate a coded field within a
Calculated Column or a Filter. Normally, coded fields
are not translated within Calculated Columns or Filters
regardless of the Translate coded fields setting within
the view's Definition (the setting is automatically
disabled when using the /rw parameter).

S1 A string referencing a field/column name
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Function Description

GETEXTERNALDATA
(S1, S2, [ S3, S4 ] or [N])

If you want to create your own composite view (see page
3-89) from another view that uses a common Link
identifier, you may use this formula to copy the field
from the originating view into the destination view. Use
the Data Dictionary Exporter (see page 2-8) utility first to
determine if the two views use a common Link
identifier.

For tables where no key is available to select a record (eg.
a flat file such as the Company Profile), you can specify a
record number (0 in the case of the Company Profile) to
load a specific record and access a data value from the
record.

S1 Name of the external view from which you will
retrieve/copy information

S2 Name or column heading of the external field to be
copied

S3 Name of the common Link identifier

S4 Name of the field in the destination view that shares
the Link identifier with the external view

S3 and S4 will be repeated when the field to
retrieve/copy requires more than one Link identifier

N Record number, used without S3 and S4

NOTE: For 'N', you can use RECORDNUMBER() to
determine the correct record number to use.
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Function Description

GETLINKEDRESULT(S1,
S2, [S3, S4])

Use this formula to retrieve the Total, Min, Max or
Average result from a column in another view.
Optionally, you may use the formula to copy the subtotal
of the original column for the matching fields in another
view. This result might then be used in a calculation
within the destination view.

S1 Name of the associated view

S2 Name of the field whose column result is to be
returned in the destination view

S3 Name of the matching column in each view

S4 Field name used for matching

NOTE: The 'associated view' does not have to have a sort order
set nor be summarized.

GETLINKEDVALUE(S1,
S2, S3 [, S4])

This function may only be used within a workspace.
Users familiar with Excel might think of this as
VLOOKUP. Optionally, using the fourth parameter, this
function can return the next highest (positive number, eg.
1) or lowest (negative number, eg. -1) LinkField from the
linked view when an exact match is not guaranteed.

S1 Name of the associated view

S2 A common field that exists in both the views (note:
this may be a calculated column)

S3 Name of the field being copied from the associated
view

S4 optionally returns the next highest or lowest
LinkField

GETNAMEDITEMS(S) This function is used in conjunction with the “Named
Item File” (as described earlier in this addendum) and
returns the string assigned to the “Named Item”. The
string may need to be converted using the VALUE or
DATEVALUE functions depending on how it is being
used.
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Function Description

QUERYDATE
(”Prompt” [,Optional
Date [, N]])

This function prompts the user to select a date from a
pop-up calendar with the default date being either today
or an optional date, if present. In all cases, the last date
entered becomes the new default date for subsequence
refreshes.

QUERYNUMBER
(”Prompt” [,Optional
Number [, N]])

This function prompts the user to enter a numeric value,
the default being zero or the Optional Value if present. In
all cases, the last value entered becomes the new default
value for subsequent refreshes.

QUERYSTRING
(”Prompt” [,Optional
String [, N]])

This function prompts the user to enter a string, the
default being blank or the Optional String if present. In
all cases, the last string entered becomes the new default
string for subsequent refreshes.

RECORDCONTAINS
(X1[, X2])

Returns those records having a database field (i.e. a
non-calculated field) equal to the value of X1.

� If X2 is used for Date or Numeric fields, indicates a
range between X1 and X2;

� If X2 is used for Text fields, any non-zero value
indicates 'case sensitivity' is required.

NOTE: The field containing the result must form a part of the
database table; however, it does not need to form a part of the
actual view.

RECORDNUMBER() Returns the physical record number in a "flat" or "index
random" file. The record number can be useful for a
developer when attempting to track down a problem
with selected data. The value returned for an "idt" file is
undefined.

ROW() Returns the ordinal position (row number) of the record
at the time it is read. This value will remain static,
regardless of whether the view is later sorted into
another a different sequence than was used when the
record was originally retrieved from the data file.
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Function Description

VIEWCONTAINS
(X1[, X2])

Returns those records having a database field (i.e. a
non-calculated field) equal to the value of X1.

� If X2 is used for Date or Numeric fields, indicates a
range between X1 and X2;

� If X2 is used for Text fields, any non-zero value
indicates 'case sensitivity' is required.

NOTE: The field containing the result must form a part of the
actual view.
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